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1. Nuclei Studio IDE f&ifr 5223
1.1.  Nuclei Studio IDE f&4
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B, OGS, LU BhABA 1R Eclipse V&5 T B2 @ TAF % . Eclipse “F- & 4
KIUH . IEFEASRE EL M eclipse.org Wi T HER1S .

B RREU

Eclipse (7FGRRARST- & F BT RN REFEE78 0 AR BRI L% . Eclipse £
AN ZANTUH AWt .

® V5T H——MET Eclipse 4 4.

® CDTIiH——M=E T C/C++H KT H.
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BRI
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Eclipse XAt A3 B4, B REH S ClearCase. SlickEdit. Rational Rose DL &
HAhg — @S (UML) BFEE =79 R TIE. 1oh, et S &M EIEH PN
(GUD gmiHasthlm TAE, JF3CHR& M.

Nuclei Studio 24 7247 5 Nuclei SDK #4, 5475 /& SDK B 77 2, 7] DLy (6 Py b g i A

WRTAE, PREE s TR EED. N E Nuclei SDK VALY, FIARYERINR 75 K B 3hif .

Nuclei Studio IDE T &

N T ITAER P PR B AR, AR SORSHERE (8 SR 4 BT (1) Nuclei Studio IDE #4461 .

R AE Dz B 4i 6 bAE B A w Mk, BEAkHihE
https://www. nucleisys. com/download. php, WE 1-1 i~

FHP AT AR R B 2w Rl TR a8l RIS T RAEE, N E06 B Windows BY

Linux [/ NucleiStudio k45l (GER: SRBHE A A M) FEbt, HNESARER, HP
15 FAT IR H BoRT iAR B Ak S48 FH S AT A »
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Linux xB6-64 3 Uiouxxg6-32 *
Windows Build Tools Nuclei Studio IDE
Windows £ Windows x86-64 3 CenmonVbuntu x0G-G4 £ 3

1-1NucleiStudio IDE ¥k 61) T # 5

1.3. Nuclei Studio IDE %3

252k NucleiStudio IDE 45 A6 R4k, &R SE T30 mE 1-2 GRIEBEF AR
AEF , HHNHENT .

B  NucleiStudio #-f1

7/

® ZHMEP S 1 Nuclei Studio IDE HJ#fF. 1ER: BARAL AT R A
T SEHT o

B HBird_Driver.exe (2021.02 fRASEAS FFHEL)
® X Windows RRIRME, 0 Ryl kg SRR 2% 1 USB IK5) 238 0.

® 7t Windows M 5i T, AR, 7522 b Kah{ii% USB B& st R 4t

VIR
® T 2021.02 AH 1] openocd JI A T HIKTIHE

B SerialDebugging Tool (2021.02 FRASE A AL
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® X Windows R#fE, My E# BB T 8. AT AT U T R SR
A I A T EME

Data (D:) » NucleiStudio IDE 202102-win64 >

e

ER EXHER x5 FI
NucleiStudio 2021/2/2 10:44 g la=ocd

& 1-2NucleiStudio IDE /& 45304 N %

2. J33 Nuclei Studio
J5 7 Nuclei Studio [IE S0~ (windows Fl linux Y3840 FHAE) -

B B X NucleiStudio IDE L NucleiStudio SO 32 R al #4704, BT B 3h
Nuclei Studio, #E 2-1 fi7RN.

B 55— X3 3h Nuclei Studio J&, F25# H X HE 2R % & Workspace H %1%, 1% H %
ARG S200 3 B TR SO, | 2-2 fis.

B B Workspace H3g2 J5, i “Launch” #41, <35 3) Nuclei Studio. 55X
& # )5 1 Nuclei Studio R ER WK 2-3 Fis.

B 2021.02 i & Nuclei Studio A5 7 Launch Bar, 52 8.1 78 Nuclei
Studio /] Launch Bar Zhe8, 7@ PE%RF R AN T
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Data (D:) » NucleiStudio IDE 202102-win64 » NucleiStudio
e &M HER e Fh
configuration 2021/2/2 10:44 prg iz
features 2021/2/2 10:44 prgla=>c3
jre 2021/2/2 10:44 S
p2 2021/2/2 10:44 S
plugins 2021/2/2 10:44 BVE S
readme 2021/2/2 10:44 itk
toolchain 2021/2/2 10:44 prglisyes
tools 2021/2/2 10:44 prglisaes
] artifactsxml 2021/2/2 10:35 XML 3744 213 KB
ecli-psec.exe Click Here 2021/2/21032 R FRRER 127 KB
Q notice.html 2021/2/2 10:32 QQBrowser HTML ... 10 KB
= Nuclei Studio User Gui e.pdf 2021/2/2 10:37 Adobe Acrobat Do... 8,129 KB
I@ NucleiStudio.exe I 2021/2/2 10:32 MNFHER 408 KB
&+ | NucleiStudio.ini 2021/2/2 10:32 [i=1ia— 1 KB
=] Ver.2021-02.txt 2021/2/210:37 SASIRY 0 KB
2-1 Wi “NucleiStudio.exe” &3 Nuclei Studio
@ NucleiStudio IDE Launcher X

Select a directory as workspace

NucleiStudio IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | [C:\Users\24954\NucleiStudio workspace} Browse...

[ Use this as the default and do not ask again

2-2 % & Nuclei Studio ) Workspace Hz%
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@ CPDE - NucleiStudio o
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
= &Welcome

SHNudeiStudio  Welcome to the NucleiStudio for C/C++ Developers

Open a file from the filesystem [ Aiways show Welcome at start up [\s

2-3 #— B 2h Nuclei Studio A

3. Nuclei Studio ZhRs A

Nuclei Studio H 2021.09 fit)5, # IDE 5 Nuclei SDK 43 %, )/ 24§ ] Nuclei Studio 7
e xs B2 Nuclei SDK %245 3| IDE Hr,  J7 AR AN [F) B O A ARCPROd 37 AN [F] i il LA, I
FRAE A [R] AR 7S N w5 22 1) SDK U565, AR B T A= AN [F] H) 2 PEBE RS T B . A F G
RVSTAR JF &t b, PLUHEFME S GD32VF103 1 LA NHIHEAN4 Nuclei Studio ThEE, FEAHT

MRS % Z R &

B E AL T 3 Nuclei SDK L34, HAiEkIEHL) SDK &4
Nuclei_ SDK.zip Al Hbird_SDK.zip, F45 & T #AH XN ) zip £

B Nuclei SDK F#i#hbl: https://github.com/Nuclei-Software/nuclei-sdk

B Hbird SDK F#Hhhl: https://github.com/riscv-mecu/hbird-sdk

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A mHg 14
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¥ dev_nuclei_next - ¥ 7branches 1tag Go to file m

‘ fanghuaqi doc: update documentation ... (] Clone ®
HTTPS GitHub CLI

-github/workflows ci: Update for different boot mode https://github.com/Nuclei-Software/nuclei [}
buildroot @ 2665fb0 module: bump submodule version | Use Git or checkout with SVN using the web URL.
conf doc: update decumentation
[,‘,J Open with GitHub Desktop
freeloader @ 85ed8c0 submodule: change payload offset
linux @ 70e1148 linux: Fix linux nuclei gpio driver [?) Download ZIP
opensbi @ 3ce5%a submodule: change payload offset to 0x200000 4 months age
u-boot @ 7b67780 submodule: change payload offset to 0x200000 4 months ago

3-1 F# SDK 1) zip 11

B K NERR sdk fY zip 435 %) Nuclei Studio #, 7ESZHF£i%EFE “RV-Tools-->Nuclei
Package Management” 7E## H 1) Nuclei Package Management & ¥ 7T H47 5 A\ #1E, i%
£ R Nuclei_ SDK.zip ‘F AL R WK 3-2. £&H7] LLTE Nuclei Package
Management & 3 5147 AH5C SDK LI ER -

& NucleiStudio_workspace - NucleiStudio IDE — o X
File Edit Source Refactor Navigate Search Project Run RV-Teols Window Help
[&][o][m][- || No Launch Configu @ _SDK Cenfiguration Teols crlee o S R DN BO P B i O R I®E P
e o 8l
= Nudle: Sy logy Homepage
& Project Explorer 12 BE%Y § =0 Nuclei Studio User Guide = O % Outiine ¥ @ BuildTargets & § = O
There are no prejects in your workspace. Nuclei SDK Documentation There is no active editor that provides an outline.
To add a project: NMSIS Documentation
@ New Nuclei RISC-V C/C+ + Project
g Ceeate 2 new Wkl project n a direcory
! containing existing code
iy Import projects...
[2) Problems 1 Tasks Bl Console £ [ Properties 4 oB EEER B2 8
CDT Build Consele ftest1]

K 3-2 # A\ SDK Manage

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA W 15
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@ NucleiStudio workspace - D

NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run RV-Tools

[o] = | [No Launch onfigurations

Window Help

D= T RS- ERN RO HH R S RN R IR RRY Yo R
Hrfr-ede-o-|m Q@
(¢ Project Explorer 52 BSY § =0 = B 5=outine 2 @BuidTargets & § = O
There are no projects in your workspace. There i no active editor that provides an outline.

To add a project:
Nuclei Package Management - o x
€@ New Nuclei RISCV C/Cs+ Project L] 9 9
Create a new Makefile project in a directory | - Nuclei Packages
B containing existing code
oo Corces o Name Size Status Owner Descrip|
reate 2 new C or Ct+ proje
9 Create a project.
R Import projects.
oG EBEEAlre-no-=-0
< >
View log
L]
A 3-3 BAHGE
AR /2N

@

Fle Edit Source Refactor Navigate Search Project Run RV-Took Windaw Help

&0 |= * || No Launch Canfigurations ~ o v md B R~ Dt RO E ST GG B0 LIS

P~F D oD~ a ®|&E

& Project Explorer £ %7 E=0 = 0 % ouine ! @ BuldTargets & § = O

There are no projects in your workspace. There is no active editor that provides an outline.

To add s project:

© B Nucks RISV €+ Bro I8 Nuclei Package Management - o by

v Nudlei RISCY C/C+ Project
Nuclei Packages
Name Size Status Owner Dascrip)
- B w [ Scftware Development Kit
Creste & project., © [ sakonacielsck
£ Import projects ] 034-dev

ssove [ s

Nuclei N/NX/UX Embedded

soEaEEE #e-0-=0

i

View log

K 3-4 Bt e

B OHE—AN LR, WTRESERAS Y, % “File --> New --> New Nuclei RISC-V C/C++

ARSCAF TR N AR IS RS BHSOIGIT A, R SRR T IRARAL, AL, Sl A 2 it 7 i

P

#o g 16
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Project” , 4 K 3-1. ] PLTE Project Explorer #{ & /i “New Nuclei RISC-V
C/C++ Project”

£ Nucleistudi wodspace - NucleiStudia IDF - o x

File | Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

New ARFSHRAND | @ New Nuclei RISC-V C/C++ Project b~ S - R+ Din| @O GG B O RISD -
Open Fle. [ Makefle Project with Existing Code.
Q s|[@
P e
Recent Fles > 5 Project = O g Ouline 3 @BuldTargets & § = O

ST Comvertto a C/CH+ Project (Adds C/C++ Nature) There is o active editor that provides an outline.

Cerl+Shift+W | §9  Source Folder

[ File from Template
@ Class

7 Rename. r |03 Bamee
&) Refresh F5 [ Other ctlsN
Convert Line Delimiters T >
Print, cisp
g Imp
4 Exp
Properties Alt+E
Switch Waorksp:
Restart
Edt
[£ Problems 2 ] Tasks & Console [ Properties Y 8§ =08
0items
Description . Resource  Path Location Type
a
& 3-5 ff S A A i H
S - I)\
fle Edit Source Refactor Navigste Search Project Run RV-Took Window Help
40 | = No Launch Configurstions v on v M- - ~Blw BO G-~~~ G H5-0-9 - Q-5 4~
aQ m|E
O g Outine 1 @BuldTargets & § = O
There ix no active editor that provides an outine.
£ Problems 12 & Tasks [ Console [ Properties
0items

Description Resource  Path  Locstion Type

3-6 M Project Explorer Hh&)& 0 H

B 3-8 fin, TEFRHAE LT ORI E ) R 3R A5 AN [F] AR ) SDK, & Fh % — Board
T K SDK, & #4855 SoC & Board I/ . iX H L RVSTAR JFRHCNEI, B LLIX —Ii%k

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA - mg 17
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# “GigaDevice->GD32VF103->Nuclei GD32VF103 RVSTAR Board->sdk-

nuclei_sdk@o0.3.2-dev”

o M “Next” #HANT—,

) Creating Nuclei RISC-V C/C++ praject

Create Nuclei project

Please choose the right development board

~ Nuclei
v Nuclei FPGA Evaluation Demo SoC
~ Nuclei FPGA Evaluation Board
sdk-nuclei_sdk @0.3.4-dev
v GigaDevice
v GD32VF103
 Nuclei GD32VF103 RVSTAR Board
sdk-nuclei_sdk @0.3.4-dev
+ Sipeed Longan Nano Board
sdk-nuclei_sdk @0.3.4-dev
~ GD32VF103V-EVAL Board
sdk-nuclei_sdk @0.3.4-dev
v LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.4-dev

Details

Bl 3-7 dhFRd I H 2R

B BRI E RS E T 3-9 Fiias, [RIDN RVSTAR 1A IZ A2 € 1 N205, HXT T
arch #1 abi 43 7)7& rv32imac 1 ilp32, AL Core EIIABEEN . [FIFE, RVSTAR &
PRAX S FF—Fh FLASHXIP F##5i0, Frll DOWNLOAD X &t A B . i

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A
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“Finish” 52 TFEAE .

e o x
Create Nuclei project

Please select the relevant configuration item

Praoject name: test_rvstar

Project Example: Helloworld @app-nsdk_helloworld P
Toolchain: Nuclei RISC-V GNU Toolchain v
Newlib Selection: Newlib Nano ~
Download/Run Mode: FLASHXIP download made, program will to be download into flash and run directly in Fle ~
USB Driver Present: O

Select NMSIS Library: No NMSIS Library used ~
Nuclei RISC-V Core: N205/Bumblebee Core(ARCH=rv32imac, ABI=ilp32) ~
Application Compile Flags: -02

(?:' < Back Next > Cancel

3-8 MEPRRE FPARAR S AR O< v L

® Nuclei Studio ] LURYE A R B TREARAS A [F ) SDK P85, 5] 41 FreeRTOS AR
ARSI M) OS %%, Demo_dsp #EtR TAERT LA B0 NMSIS FESCfF. 5T
NMSIS #41{5 215 2% (https://doc.nucleisys.com/nmsis/index.html) . X H DA
Demo_dsp Afl, “Project Example” i%&#t “baremetal_demo_dsp” . [ AfdH
dsp T.#8, TREUIN NMSIS fF, Frll “Libraries” £ “NMSIS DSP” .

® Nuclei Studio A DR B it TAZIS (s 00 A 20 W B TAERIE . X Bk £ Al iz
SITED, FrLL “NEWLIB” i%3% “newlib-nano without float” . 4Lt ZE2%
“Optimization Level” & “Optimize more (-02) 7 . ZJ5—HERF “Next” H
F] “Finish” .

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 19
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B Nuclei Studio °] PAPREAE S TR R BIE I Hrddr i) TR E 3-10 Fis, HEZEBK
TR, AT P2, #%F “SDK Configuration Tools” T i B ik T A .
W 3-11, WEREESGIFENES, B “Optimization Level” 5y “None (-

00) 7, miii “Save” BHUET. 1 3-12 (ESULINE B ) TR A 4T FF 45 B
KHL, ERE “clean” JERR— T LR, F ST bR R TR,

@ CPDE - RVSTAR_demo_dsp/application/main.c - NucleiStudio - [« ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&|[0][m] ORun TIRVSTAR dema_dsp ¢ R BrA v BT BN SN B ATE TG T ETO TR A& Y THveeror [Quick Access| | = | B
& Project Explorer ¢ & ~T 0 Emaing ? B Qutline
" 1 #ineluda cetdine b ~ vEARY e R

> u stdinth ~

u stdioh
be.h”

u puclei_sdk_soch

‘Open in New Window
u ref convh

Show in Local Terminal >
@ Core u riscy_mathh

DSP Copy Ctri+C w READ CYCLE
& Library Paste CuleV __Bet_rv_cycle -
v %ot X Delete Delete
Remaove from Context Ctrl+ Alt+ Shift+ Dowr
~ = gd32vf103 .
gares (o0 R
=Commen  Move tycle;
RVSTAR demo i Rename... F2 fle; i
. ed: uint32 1
= ‘E‘:‘::rrl‘ :::; =8 # BENCH TRST(
4 # BENCH_INIT)
Build Project # BENCH START(
Clean Project # BENCH_END(
Refresh Fs. \ # BENCH_ERROR(
Close Project [nitialized\n"); \ # BENCH STATUS(
Close Unrelated Projec \ h # BENCH FINISH()
8 tect cany inont 3 A flaatid h

Build Targets
Index ? laeny
Build Configurations > |
Profiling Tools

Validate

Run As >
Debug As

Profile As

0

Restore fram Local Histo
2]
¥ Run C/C++ Code Analysis
Team
Compare With >
Configure >

Source

Properties. Alt+Enter

< >
5 RVSTAR demo dsp

3-9 77 SDK & & T.H

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 20
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Nuclei SDK Project Configuration - O X

projectName : RVSTAR demo_dsp
Configuration: Debug v
Core: |IN205 ™
ARCH : |rv32imac |
ABI : |ilp32 |
Download : FLASHXIP ™

NewLIB : newlib-nano without print float v

Optimization Level : |None(-O0) o

Extra Common Flags : | |
Extra C Flags: | |

Extra C++ Flags: | |
| |

| |

Extra ASM Flags
Extra Link Flags

Save Cancel
SDK Configuration Tools:1.0.0.0 www.nucleisys.com
FiE
Kl 3-10 BECLIE
) CPDE - RVSTAR_demo _dsp/application/main.c - NucleiStudio - o x
file Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
Elci=] orun ~ | EIRVSTAR demo_dsp_c+ | [t = DR R R Y - P R R R R A S R R AT R il oo [Quick Access] | m | &
& prlfhct Explorer 8%l% 7= 0 Gmainc = ° & OQutline . iid Tar... % Docur :
+ 1% RVSTAR demo_dsp 1 #include <stdint.h> X PEARY . W
 Includes New > u stdinth -
& application Go lnto . u stdioh
“ i B nuclei_sdk_soch
- ”“":‘:4—;": Open in New Window u o comh
oo Show in Local Terminal y u riscy. mathh
DSP & Copy CtrlsC # READ CYCLE
& Library Paste Cilv |get_rv_cyele o* enter_cycle uint64
v 50 X Delete Delete »* exit cycle  uinto
« = gd32v03 Remove from Context CtrlsAltsShiftsDown | o start_cycle  uintA 1
& Board Source £l g = end_cycle : uinté4 t
= Commen Move. o; #% cycle - uinth t
RVSTAR demo_dsp.d  Rename = " extra_cost : uinté4 t
®* bench_ercd - uint32 1
&= Import. =0 # BENCH TRSTQ
@ Bport.. 3 # BENCH INIT)
Build Project # BENCH_START()
I cmuE‘m (1] # BENCH_END(
Refresh TS5 \ # BENCH_ERROR(
Close Project dalizedin”); A\ # BENCH STATUS()
Close Unrelated Project : N # BENCH FINISHQ .
% tect ronv innot F32 A flnalio o
Build Targets > } TTLLL
Index »
Build Configurations )
Profiling Tacls )
Validate
© RunAs B
# Debug As y
Profile As y
Restore from Local History.
® SDK Configuration Tools Ctri+6
% Run C/C++ Code Analysis
Team 5
Compare With )
Configure )
Source y
Properties Alt+Enter
< >
15 RVSTAR demo dsp & ==

3-11 I B AR I B0 1%
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4. A2 B

X B PUF R H N HummingBird Evaluation Board, 1FffAbFE 28 4% N3o7(rv32imafc) iy
%, VEHHA4E Nuclei Studio H 61235 H 1% W7 .

{E Nuclei Studio IDE f//# 5 H 7] LA LA LR DL =
B fFRER H AR -

® XREEHPIER TN, (HAT#E2 IDE B D& WS 7 AR IH, Nuclei Studio
C& 78 70 #-5 Nuclei SDK. 417X 7 & 7 7= i A 00 H AR, 15 55 SR B R
o

B NCHUHEZIS AR -

® REEWMMIII, B, M A TR CAIH KSR BT T RO, A
BEAT > AL A, HT B AT RAE 53 AMH RN L B S NZIUH AT BA Oy Rl 61 8
HITRH , LA B ] B TR B 2.

mOEBRF AR

® XRHEBINTTAN, IR 7RI H 24, BT ?zﬂuﬁ%ﬂ]ﬁilﬁﬂlﬁ%ﬁ H
TiZJ7 R E B, T CAESERR TARh B ME ], B 1207 ARvegn g,
FTLAVEAE 1 A o] e B % e T R A

B LT AN Makefile 61215 H

o X LEGE S T B4 K H Makefile 8 HAh 4w 1% T BT H, #4L—F7E IDE
i TR, EHE TR, BRTITEN T, ENMESRmERGEHEM F, AR K
IDE i3855 .

N ICRERTX Uy o AT 4

4.1. BIEEREFHLIETE

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A mg 22
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A A G (g AR E sh )@ H #5278, 7E Nuclei Studio IDE A1 2 —/™ % 579 Hello
World BiH, V4P EUT.

B OHE AR, ATRAIESE ALY, &8 “File --> New --> New Nuclei RISC-V C/C++
Project” , Wil 4-1. 7] LATE Project Explorer #f FHi%&H “New Nuclei RISC-V
C/C++ Project” , 4k 4-2.

5] istudin_ uwarks - istudin IDE — o x

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

New ol S-&- B BOE-B-F-@-H-0-%-Q-i®D -
Open File.
3 Q ®|E
v e - .
Recent Files > 9 Project.. = B 5= Outline 2 @ BuildTargets & § = O
Close Editor Ctrl+W Convert to a C/C++ Project (Adds C/C+ + Nature) fbaiebohaaladiogibat pron et
Close All Editors Crrl+Shift+W | &3 Source Folder
Save Coirs |8 Folder
S [¢7 Source File
9
Save All Cirl+shiftys | (] Header File
3 P
— [ File from Template
@ Class
Move..
™ Rename. R |0 Eampl.
&) Refresh F5 9 Other. curl+N
Convert Line Delimiters To
Print.. Ctrl+P
g Import
/y Export.
Properties Alt+Enter
Switch Workspace
Restart
Exit
[Zl Problems 52 ¥ Tasks B Console [ Properties T8 =8
0 items
Description Resource Path Location Type
|

B 4-1 MRBEARTE

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 23
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—
h sdow  Hel
Config ? (=] 80 @ CEr B O ey

Q &

£ Outl ¥ Buid Targets & o
There is no active editor that provides an outiine.

2] Problems 13 &) Tasks B Console [ Propertes
0 items
Descripon ~ Resource  Pa $h Locstion

4-2 Project Explorer ¥ B2 B

KA, X BHIRAIAE Nuclei FPGA ., W&

B A 4-3 P, ARSI kR H SRR,
N307, SDK 4 nuclei_sdk@o0.3.2-dev hASKAR— SR K, 3% xt ) Board 1)

SDK, i “Next” # AT —,

nig 24
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a u]
Create Nuclei project
Please choose the right development board
~ HummingBird Details
~ HummingBirdv2 RISC-V $oC SoC: Nuclei FPGA Evaluation Demo SoC
~ Nuclei MCU200T FPGA Evaluation Board - Vendor: Nuclei
sdk-hbird_sdk @0.1.3-dev - description: Nuclei Demosoc Support Package
~ Nuclei DDR200T FPGA Evaluation Board - core_vendor: Nuclei
sdk-hbird_sdk @0.1.3-dev - website: Click to view the details
~ HummingBird RISC-V SoC Click to view the details
~ Nuclei HummingBird Evaluation Board - usermanual: Click to view the details
sdk-hbird_sdk @0.1.3-dev
~ Nuclei ! ]
v Nuclei FPGA Evaluation Demo SoC BSP: Nuclei F?GA Evaluation Board
~ Nuclei FPGA Evaluation Board - Vendor: Nuclel )
e T——— - destrllptmn:l Nutle\.FPGA Eva\uét\un Board Support Package
~ Gigabevice - website: Click so view the detals
v GD32VF103 - seh: Click to view the deralls )
 Nuclei GD32VF103 RVSTAR Board Jusewariali i s ot
sdk-nuclei_sdk @0.3.2-dev - extra documents:
. - - MCU200T SCH: Click to view the details
v sipeed Longan Nano Board - DDR200T SCH: Click to view the details
sdk-nuclei_sdk @0.3.2-dev ! Lieetovienme cetals ) )
v GD22VF103V_EVAL Board - deeu Intruductjun For MCU200T Board: CTl:k to \‘IIEW the detalwls
sdk-nuclei sdk @0.3.2-dev - Video Introduction For DDR200T Board: Click to view the details
~ LILYGO TTGO T-Display-GD32 Board
sdk-nuclei_sdk @0.3.2-dev
@ < Back Next > Finish Cancel

B 4-3 EEELE R

B R 4-2 o, R E DR BOE N S

® Project name: WiH%. XEWEN “1_helloworld”

® Project Example: it Helloworld.

® Toolchains: FA1f# F Nuclei GUN Toolchain.

o RATMNIZAZE N3o7, Frll “Core” ¥ “N307” .

® IELIFRMCIRF =M M, DUN BN SR e, X EIRATE R ILM

o

B LM FEEAEFE ER FEE MCU B ILM 1, M ILM H46347. ILM

H1 SRAM A, <fHEER.

B FLASH FHME PRI B 3 ik 29 3R Flash [X (8], K4 QRS B2 48 M 1k 2

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A mg 25
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WAE ILM fhhEX (8], RUREFE B E 3 N E/E MCU K Flash /1, {H/2& LH
Ja BRI 5| SR BAIEEMIZ ) ILM F, ARG M ILM FFEHAT. Pk
51t Flash 1, A HER,

B FLASHXIP F#E MRS B K Flash [X[0], RMREFE PR B R E8AE
MCU ] Flash 1, JFE#M Flash HGEHAT . BBFHEESE Flash 1, Ao H
E5,

® AR IR LI AT R E

® iii“Finish”7¢ i LA A

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 26
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] o x

Create Nuclei project

Please select the relevant configuration item

Project name: 1_helloworld

Project Example: Helloworld @app-nsdk_helloworld w
Toaolchain: Nuclei GNU Toolchain v
Newlib Selection: Newlib Nano w
Download/Run Mode: ILM download mode, program will be download into ilm/ram and run directly in ilm/ram ~
Select NMSIS Library: MNo NMSIS Library used ~
Muclei RISC-V Core: N307 Core(ARCH=rv32imafc, ABI=ilp32f) [
P-Extension(DSP) Present: O

Application Compile Flags: |-02

® = Back MNext = Cancel

B 4-2 g I H R AR

B E 4-3 fn, AR H 3560 Hello World T H 42 5¢ .

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 27
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[&5 Project Explorer 23

1 1_helloworld

]  workspace - 1 | c- IDE - [u] X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
vH@Lheuuwm\a,debug,qemu - = - -G E e SR E -G it Q- _r®E & [HEE
=] Q s
= B [@mainc B = B 3¢ Outine 5 © Buid Targets =g
BES Y & 1 s ses license details. ~ OB R e % ¢
2 #include o adioh
5 #include _—
4 #include > H tmeh
5 #include "nuclei_sdk_soc.nm U stdibh
6 & nuclei sdk soch
7% void print misa(veid) o print misa(void) : veid
et # RUN_LOOPS
s CSR_MISA_Type misa bits = (CSR MISA Type) _ RV_CSR_READ(CSR_MISA): # RUNLooPs
10 static char misa chars(30]; oid
o Snte © smsex - 55 o main(void) : int
if (misa_bits.b.mxl = 1) {
misa_chars[index+t] = '3';
misa_chars[indexss]
} else if (misa bics.b.ml i
misa_chars[index+:] = '6
misa_chars[index++] = '&
} else 1T (misa_bits.b.ml = 3) {
misa_chars[index++] =
misa_chars [index+t
misa_chars[indexss]
}
if (misa bits.b.i) {
misa_chars(index++] = 'I';
)
if (misa_bits.b.m) {
misa_chars[index+t] = 'M';
'
if (misa bits.b.a) {
misa_chars(index++] = 'A‘;
1 }
52 if (misa_bits.b.b) { .
[#0 Problems ¥ Tasks & Console [ Properties Y 8§ =0
0 errors, 1 warning, 0 others
Description Resource  Path Location  Type
> i Warnings (1 item)
| writable | smart insert 1:1:0 a|

T LR A
ik,

9 SR I 4-4

4-3 5E AR Gl 22 1 H

“Project—> Build Project” &Y “

7 AL RITIZIH AT

ASCAFPITIR N AR IR B R BRI G I, RE KB B IRARAL, ALk, s A 2 APt 7
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] iStudio_workspace - 1_helloworld/applicati in.c - iStudio IDE - o X
Fle Edit Source Refactor Navigate Search Project Run RV-Teols Window Help
[&][o][@][0rn || [E] 1_helloworld debug germu mid [8-R-G B BB E - - -G % -0 8- y-[dEr
B~ 5~ ~ |2 o ®|@
&5 Project Explorer & = 8 [2 mainc &8 = O 5= Outline 52 @ Build Targets = g
B% Y & ; is ~ FEERY o % §
& 1_helloworld 2 #include U stdich
s finclude <time. —
¢ f#include <stdlil i timeh
#include "nuclei_sdk soc.h” U stdibh
o nuclei sdk soch
7= void print_misa(void) © print misa(void) : void
{ # RUN_LOOPS
CSR_MISA Type misa bits = (CSR MISA Type) _| RV CSR READ(CSR MISA);: # RUN_LOOPS
static char misa_chars[30]: vaid) it
wints_t index = 0: © mainlveid) : i
if (misa bits.k.mxl = 1) {
nisa chars[index++]
misa_chars[index++] =
} else if (misa bits.b.mxl {
misa_chars[index++]
misa_chars[index++] =
} else if (misa bits.b.mxl {
misa_chars[index++]
misa_chars[index++]
misa_chars[index++]
if (misa bits.b.i) {
misa charslindesssl = '70: v
[2] Problems ] Tasks [ Console 52 [ Properties O 4G BEE&#E-3-=0
€DT Build Console [1_helloworld]
Invoking: GNU RISC-V Cross Create Flash Image -
riscv-nuclei-elf-objcopy -0 ihex "1 _helloworld.elf" "1 helloworld.hex"
Finished building: 1_helloworld.hex
Invoking: GNU RISC-V Cross Create Listing
riscv-nuclei-elf-objdump --all-r nangle --lin nv —-wide "l1_helloworld.elf" > "1 _helloworld.lst"
Finished building: 1_helloworld.lst
Invoking: GNU RISC-V Cross Print Size
riscv-nuclei-elf-size --format=berkeley "1 helloworld.elf"
text data bss de hex filename
25998 se0 2280 2 7000 1_helloworld.elf
Finished building: 1_helloworld.siz
11:33:1€ Build Finished. 0 errors, 0 warnings. (took 5s.835ms)
-
Writable Smart Insert 9:48:193 ES

4-4 SEHRIT F 4

B UK 4-5 i, fF Hello World T H H3hA sad #2H,  HXER ) OpenOCD At & L4 [F]
e M H BT EE, HP LA S A S H 2% “Hello World” ,  sidy
“Debug As —>Debug Configurations” F /&3 A AC B #3172 H . Debug 5 Run fi
FAAH A A & SCfF, BT aliEd “Run As —>Run Configurations” 7.

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 29
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio

- 9 x
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
&][0][m] 0Run 11_helloworld_debug o~ B A A GOSN A ST e v O TR ATINE SISy i o [Quick Access] | = | B
& Project Explorer : =&le 770 @mainc £ Outline s . %
~ & 1_helloworld New Tt pense details. X vEARV o &
 Binaries u stdioh
 Includes Celkno u timeh
« & application Open in New Window oc.h® u stdiibh
4 main Show in Local Terminal >  nuclel sdk_soch
& Debug o print_misafvoid) - voicl
- & nudlel sdk 'C‘TW mf = main(yoid) : in
: _bits = (CSR_MISA_Type) __RV_CSR_READ(CSR_MISA);
NMsIS % Delete Delete chars[30];
SoC ; . B
Rema rom Context Ctrl+Alt+Shift+ Down
Thellowarld ¢ g SR e 1 g
Move lex++] = '3°;
i ex++] = '2
Rename. F2 §ts.b.ma
b L. ex++] = "6°;
BOTS ts.b.mxl == 3) {
Build Projects ax++] = "1
Clean Project “::1 = _g:-
Refresh pg fexe+l = 78
Close Project ¢
Close Unrelated Project ex++] = 'I°; w2
Build Targets > =
Index b = o B - U= T
Build Configurations >
rld. elf 2
Profiling Tools * & Cos Linker
Validate h=rv32imafc -mabi=ilp32f -mcmodel=medany -msmall-data-limit=8 -02 -ffunction-sections -fdata-sections -fno-common -g -T "D:\CPDE\1_helloworld\nuclei_sdk\SeC\hbir
Run As 5 | 1_helloworld.elf
4 Debug As 3| © 1 C/C++ Container Application
Profile As > [ 2 Local C/C++ Application | arid. hex®
Restore from Local History... Debug Configurations...
@ SDK Configuration Tools Clil+6 o
% Run C/C++ Code Analysis Create Listing . . . .
. , r-source --all-headers --demangle --line-numbers --wide "1_helloworld.elf" > "1_helloworld.lst
bworld. 1st
Compare With >
Configure Print Size
5 rmat=berkeley "1_helloworld.elf"
Source 51 dec  hex filename
" 1le134 2796 1_helloworld.elf
Properties . AltsEnter 1004 eiz
20:86:52 Build Finished. @ errors, 8 warnings. (took 35.629ms)
v
< >
&1 helloworld

Kl 4-5 JF )3 iR Blic B ik

B W 4-6 fron, AT IR H L E S “Hello World_Debug_OpenOCD” T\ H )
AR T R S IR 2 45 & OpenOCD #EAT F# AR 1%, ATULEE 6
AT VEAN T A
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@ Debug Configurations O X
Create, manage, and run configurations ﬁ\
EEYEIIEER Name:‘17hech0r\d7debugiopenocd |
type filter text [ Main - % Debugger| & Startup % Source [ Common| % SVD Path
[€] C/C++ Application .
[€] C/C++ Attach to Application loice:
=1 C/C++ Container Launcher ‘LhSHDWOV‘d Browse...
[ C/C++ Postmortem Debugger C/C++ Application:
[€] C/C++ Remote Application ‘Debugﬂ helloworld.elf
Cit C/C++ Unit =
=1 GDB Hardware Debugging Variables... | Search Project... Browse...
v [E1GDB OpenOCD Debugging Build (if required) before launching
El 17he|low0rldideblfgiupenocd Build Configuration: Select Automatically ~
€1 GDB PyOCD Debugging
1GDB QEMU Debugging (O Enable auto build O Disable auto build
€1 GDB SEGGER J-Link Debugging (® Use workspace settings Configure Workspace Settings...
@& Launch Group
# Launch Group (Deprecated)
Filter matched 14 of 15 items Reverl ATl
@ Close

K 4-6 HahERK OpenOCD L&

4.2. NCHHBEEIANQEHIME

KA FanEH IDE NS F W H BESACEHIE, APl N3oy I H G E] 31T
BN, TiH MR (https://github.com/riscv-mcu/Nuclei-Studio IDE-Project-Package) .
B 4-7 s, WHRHEIHAES SRBHH AR,

7E%:T Windows ] Nuclei Studio IDE FF & Ei 74, R H PR “ el FaialaE TR,
A BN E I H A A B nuclei-sdk SO, FHRNBSAE TN —T i BARN4H.

[E] README.md Update README.md

[E] nuclei-eclipse_demo.rar update package

K 4-7 fiF github BT H S

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 31
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¥ nuclei-eclipse_demo.rar K450 FEfEE G, NAEWE 4-8 i, 500:

FEHR BN HES e

settings 2020/8/5 17:46 pvgl=c

application 2020/8/5 17:46 g ey

nuclei sdk 2020/8/5 17:46 LS
] .cproject 2020/8/5 17:46 CPROJECT 324
| .project 2020/8/5 17:46 PROJECT {5
" | hello_world debug openocd.launch 2020/8/5 18:11 LAUNCH 3244

Kl 4-8 EFEFARIH
B I H SRR S setting, .project F.cproject
B i H &1 Debug ¥ & 3 f4*.launch
B nuclei_sdk 3Cff3%k
BN AFTRG 7> SDK JEARES
B application 4%
eS8 hello_world #4175/ () main g8 )40 .

T BRATEIFRHEA, SALRNT:
B {EHAE IR “File—>import” .

B IE 4-9 s, i%E#F “Existing Project into WorkSpace” J&, fMiii “Next” .

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA - g 32
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@ Import O x
Select

Create new projects from an archive file or directory.

Select an import wizard:
type filter text
v & General
& Archive Fil
= Existing Projects into Workspace
3 File System
T Preferences
2 Projects from Folder or Archive
e CfC++
= Git
& Install
& Oomph
& RPM
& Run/Debug
= Tasks
& Team
e TextMate
@ Tracing
&= XML

@ <Back Finish Cancel

K 4-9 P AT

B gidi “Browse” , EFFHESAMITH AR, WK 4-10 P,

@ Import O X
Import Projects J;L/
N . N . ’
Select a directory to search for existing Eclipse projects.
(®) Select root directory: H v ‘I Browse... I
(O Select archive file: Browse...
Projects:
Select All
Deselect All
Refresh
Options

[] Search for nested projects

] Copy projects into workspace

[] Close newly imported projects upon completion
[ Hide projects that already exist in the workspace

Working sets

[CJAdd project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

K 4-10 @EHHEIAMTH

ASCAFPITIR N AR IR B R BRI G I, RE KB B IRARAL, ALk, s A 2 APt 7 Wi 33
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NPT H R IDE BB, Ak “Finish” W 4-11 B

& Import

Import Projects

Select a directory to search for existing Eclipse projects.

O

X
=
7|

(® Select root directory:l DACPDE\hello_world

VI| Browse... |

() Select archive file: Browse...
Projects:
hello world (DACPDE\hello_world) Select All
Deselect All
Refresh
Options
[]Search for nested projects
[ 1 Copy projects into workspace
[ Close newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
[] Add project to working sets New...
Working sets: Select...
@ < Back Next > Finish Cancel

K 4-11 RAIHE A ITH

ASCAFPITIR N AR IR B R BRI G I, RE KB B IRARAL, ALk, s A 2 APt 7
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B 7f IDE (WU H S HE SRR BoR RATUH K HRKE WK 4-12 PFos. oA THERIAN
N307 H)% 1%k, Nuclei SDK {¥ 112 helloworld & FH 3|10, 75 %5 £ ) Nuclei
SDK J5fi%i% 15 7] Github Chttps://github.com/riscv-mcu/hbird-sdk) FRERG .

v 1= hello_world
il Includes
= application
& nuclei_sdk
= hello_ world _debug openocd.launch

B 4-12 RIS 05 P4
4.3. TERFIHEEITHE

ATEA Bl g FH T30 75 :7E Nuclei Studio IDE 6/ —ANF 7 %2 X i) Hello World T
H. H&# N HummingBird Evaluation Board, W% N N307. 1%/7i1%kk T RIETH 2 4b, 1B
BT E SRS, AP IRINT

4.3.1. F3hEIEW B
B ESEER IR “File—> New —> C/C++ Project” . & 4-13 ffi7R.
B 4-14 PR, fERHEE DR ROE T S
® Project name: TiH 4.

® Use default location: WA %k 7 kWi, < FHERIAN Workspace I A7t
TiH .

® Project type: % “Hello World RISC-V C Project” .
SR )5 mi i Next #EN T —20
B 0K 415 B, RS E DI E Hello World it H BIZEAAE B

® Hiff “Source” MEIMN B NE, HEHDT “Next” #HENT—H,

AT A A REAC SRR A, RESKBECRETHRE, AR, S A 2 iR aidE 7 A g 35
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WU 4-16 FTR, FESRI IO E OB E I TR e R AR

o ZLIRA LM ERIME BT B, EERd “Next” #EANTF—H.
B RSB E H i E I s A R RISC-V T A %%

o A ERLE, HiEER “Finish” , £ I(FE5EM T Hello World i H (172 .
G5 Hello World 5 H S 40 4-17 AR,

B i —A> application CfF%. NE 4-18, & LFEALA 7% $E New —> Folder, #iA
application, fifi “Finish” 5E&HI & L, 0& 4-19. # main.c # A application 3
Ao SE T 432K

@ CPDE - NucleiStudio - [« ®
[ )it source Refactor Navigate Search Project Run RV-Tools Window Help
2 @l B ErTridrOr R IBG S o B [Quick Access|| = | [
Open File.. L | D ]
+ Open Projects from File System.
Recent Files 3 Bl Convert to a C/C++ Autotools Project An outline is not available.
e = Convert to a C/C++ Project (Adds C/C++ Nature)
- "W & Source Folder
I trleShiftsW 5 Folder
¢ Source File

¥ Header File
File from Template

© Class
Task
o Example..
F5 [ Other_ cul+N

wert Line Delimiters To

i Tl +F
Import...
Export..
Properties Alt+Enter

Switch Workspace
Restart
Ext

© Console
Mo consoles to display at this time.

Kl 4-13 B C/C++ Project

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA - g 36
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] O X

C Project =4

Create C project of selected type =

Project name:l 2_helloworld I

Use default location!|
Location: DACPDE\2_helloworld

Browse...
Choose file system: [default

Project type: Toolchains:
GNU Autotools | Risc-v cross Gecf
Executable

@ Empty Project

& Hello World ANSI C Project

& Hello World RISC-V C Project

@ Nuclei SDK Project For GD32VF103 SoC

@ Nuclei SDK Project For HummingBird SoC
Shared Library

Static Library

Makefile project

< >

Show project types and toolchains only if they are supported on the platform

@ < Back Finish Cancel

4-14 % & C Project Tl H 4 fi !

] O X

Basic Settings =~

Basic properties of a project ——

Author ‘

Copyright notice ‘Vour copyright notice

Hello world greeting ‘HeHo RISC-V World!

Source I\ I

Linker other options: ‘

@ < Back Finish Cancel

4-15 % & Hello World T H 5 A5 &

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7 WG 37
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() O
Select Configurations —
Select platforms and configurations you wish to deploy on E
Project type: Executable
Toolchains: RISC-V Cross GCC
Configurations:
&% Debug Select all
1% Release
Deselect all
Advanced settings...
Use "Advanced settings” button to edit project's properties.
Additional configurations can be added after project creation.
Use "Manage configurations” buttons either on toolbar or on property pages.
@ < Back Finish Cancel

4-16 BB IH AR s KA

@ CPDE - 2_helloworld/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&1[0[m] ORun  myProj Debug =hs B A S B ON WD A E LG EYO A ATISE T

& Project Explorer v ot
~ 2 helloworld
Wincipdes T 00 [l e e
main
“ main.c
6 Copyright
7 Description
#include <stdio.h>
Demonstrate how to print a greeting message on standard output
and exit
WARNING: This is a build-only project. Do not try to run it on a
18 * physical by nce it lacks the device specific startup
22 main(void)
23 {
24 printf("Hello RISC-V World!™ "\n");
ks @ Console
CDT Build Console [2_helloworld]
2 helloworld

4-17 Q)52 5% Hello World i H 1) 5

7 & Outline

u stdioh
* main(void) : ir

- [« X

Quick Access|:| = | B8

BRXow

M@ vmY

ASCAF TR N AR RSO RS R BRSO G, RGBS IR, ALk, SRR A 2 APt 7 s

[E]

N
1T o
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@ CPDE - 2_helloworld/main.c - NucleiStudio

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&][0[m] ORun @ myProj Debug

& Project Explorer

& main.c

o BvAvLa®vON

v B2
 incl__New

>F Project..

@main  Colnto

Open in New Window
Show in Local Terminal
# Copy
Paste
% Delete
Remove from Context
Source
Move.
Rename...
L Import...
: Export..
Build Project
Clean Project
Refresh
Close Project

Close Unrelated Project

Build Targets

Index

Build Configurations
Profiling Tools

Validate

Run As

Debug As

Profile As

Restore from Local History...
SDK Configuration Tools
Run C/C++ Code Analysis
Team

Compare With

#0

40

Configure
Source

Properties

Ctrl+Alt+Shift+ Down

File

2P @vEvevevigvOroAUvArins

lFoldef
>

@ Class

Qi+C & Header File

CUlV ¢ Source File

Delete . Source Folder

% C/C++ Project

© Convert to a C/C++ Project (Adds C/C++ Nature)
= Example...

= Other..

>

Cirl+N

0 RISC-V World!™ "\n");

, Pconsole
ielloworld]
>

Culeb

Alt+Enter

5 2 helloworld

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7

15 is a build-only project. Do not try fo run it on a
ard, since it lacks the device specific startup.

K 4-18 4TIFHd sk

@ New Folder

Folder

Create a new folder resource.

Enter or select the parent folder:

2 helloworld

e =
» =2 _helloworld

Folder name: application\

Advanced >>

Cancel

K 4-19 SEReHd ik

- [« X

Quick Access|! = | 8§

& Outline a5k .. %
R em
u stdioh
 main(void) : int
s®@vmv=no

TS 39
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4.3.2.Bic B H K nuclei_sdk

AT AWK nuclei_sdk JIAEITH 1, SDK FIEAR N BEASCAIEGNNH, v LhSs%
https://doc.nucleisys.com/nuclei sdk/index.html. #1575 E A H SDK I H AR 4F, &3
Github ZREU 4= #1#) Nuclei SDK J§fi%, #4101 F: https://github.com/Nuclei-Software/nuclei-
sdk. AFAA# nuclei_sdk A helloworld 75 Z i SCAEIMA NI H 2088, HARBGIRINE .

® it A\ Nuclei Studio ] 2_helloworld 5l H , %840~ 5 %% 00 nuclei_sdk J§ 0.

& WK 4-20 fili7n, 1E Project Explorer £ 71" 2_helloworld Wi H, i fEbsf
B, % “Properties” F1HF LFE W B T .

& WHE 4-21 Fin, fE#HAE O S “Resource” , 7E4 A Location £ H H
Heh A M Sk bR =, e SR s D HEN 2_helloworld i H 1 314
Jefr HE

& KB 4-7 FAH1 nuclei-eclipse_demo.rar L4540 5 1) nuclei_sdk 30443 5 il
T 2_helloworld i H T HX T, WK 4-22 fx.

& [ 3] Nuclei Studio, 7£ Project Explorer 1%t 2_helloworld 3 H, i bxs
fie, % “Refresh” , WK 4-23 iz,

€ Refresh 2 J5 2_helloworld Wi H ) F{# 7] LLFE 3] nuclei_sdk SC4F32, g 4-24
i, ZUMESER T nuclei_sdk LIS

AT A A REAC SRR A, RESKBECRETHRE, AR, S A 2 iR aidE 7 A g 40
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@ CPDE - NucleiStudio

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

1 hello_world_debug o R B R v A BTN WD AT E TG TETOTATATISS A
= =

4|0 [=| ORun

& Project Explorer :
~ 1 hello_world
 Binaries
# Includes
& application
& Debug
& nuclel sdk
hello_world_

New
Go Into

Open in New Window
Show in Local Terminal
Copy

Paste

Delete

Remove from Context

Source

Move

Rename...

s Import...

# O

%0

Export

Build Project

Clean Project
Refresh

Close Project

Close Unrelated Project
Build Targets

Index

Build Configurations
Profiling Tools
Validate

Run As

Debug As

Profile As

»
Ctrl+C
Clrl+V
Delete
Ctrl+Alt+Shift+ Down
»

Restare from Local History..
SDK Configuration Tools ctri+6
Run C/C++ Code Analysis

Team
Compare With
Configure
Source

»
5
»

le » nal
el

Properties

AltsEnter |

* B Qutline

An outline is not available.

Kl 4-20 7T TRE B BT i

[Quick Access||| = | B

s} *

~Evs

@ Properties for hello world
type filter text Resource v v
(Resource Path: /hello_world
Builders Type: Proi c:t
C/C++ Build S eI
C/C++ General | Location: DACPDE\hello_world
Linux Tools Path | Last modified: 2020585 6H F48:09:33
MCU Text file encoding
Project Natures | (o) Inherited from container (GBK)
Project Referenc () Other: |GBK
Run/Debug Seti ) N 3
Task Repository [] Store the encoding of derived resources separately
Task Tags New text file line delimiter
Validation (® Inherited from container (Windows)
WikiText () Other: |Windows
< > Restore Defaults Apply
@ Apply and Close Cancel
4-21 fE#H & N hello_world 3 B i S0 e B
ARSAPPTR A B IR R RN ITAT, RECRBHR B IR, AHERE. S HIBEE A 2 A a7 2. g 41
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.settings

application

2020/8/517:46
2020/8/5 17:46

S
S

L

nuclei sdk

2020/8/5 17:46

{3 I

O
O

' | hello world_debug_openocd.launch

@ CPDE - myProj/src/main.c - NucleiStu

.cproject
.project

udio

2020/8/517:46
2020/8/5 17:46
2020/8/5 18:11

4-22 i nuclei_sdk scfE32

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

%][o][=] -
& Project Explorer =
& muProi
New
Golnto
Open in New Window
Show in Local Terminal
w Copy
Paste
% Delete
Remove fram Context

Source
Move._.
Rename...

& Import...

i Export..
Build Project
Clean Project

__Refresh

Ctri+C
CtrlsV
Delete
Crl+Alt+Shift+ Down

Close Praject
Close Unrelated Project
Build Targets
Index
Build Canfigurations
Prafiling Tools
Validate
© RunAs
4 Debug As
Prafile As
Restore from Local Histary..
@ SDK Configuration Tools
% Run C/C++ Code Analysis
Team
Compare With
Configure
Source

Properties

= myProj

Ctri+6

Alt+Enter

~ | No Launch Configurations - on: -

»

»

o P T R -TRN) [ TT U CpRp gy g TP S S ey
& main c
10 g%
3 Name : main.c
4 Author
5 Version
6 Copyright : Your copyright notice
7 Description : Hello RISC-V World in ¢
8
18
11 #include <stdio.h>
12
13=/

14 = Demonstrate how to print a greeting message on standard output
15 * and exit.

17 * WARNING: This is a build-only project. Do not try to run it on s
18 = physical board, since it lacks tha device specific startup

18 */

20

214

nt
22 main(void)

3 {
4 printf("Hello RISC-V World!™ "\n");
5 return 8;

lems sks @ Console per
GNU MCU Eclipse Packs console

Loading repos summaries...

Parsing cached content file "D:\Packages\.cache\.content_www_keil_com_pack_index_pidx.xml"...
File does not exist, ignored.

Identifying installed packages...

Found no installed packages.

Completed in 3ms.

Mo installed packages.

Completed in 3ms.

4-23 FlFr T2

CPROJECT 3t
PROJECT 344
LAUNCH 3744

= 0 & Outline = sk

u stdioh
= mainivoid) - int

- =] x

|Quick Access| | & |8
=n

LR I

ASCAFPITIR N AR IR B R BRI G I, RE KB B IRARAL, ALk, s A 2 APt 7
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v == 2 helloworld
m Includes
v (= application
g main.c
v = nuclei_sdk
v = NMSIS
= Core
v = 5S0C
v = hbird
= Board
v = Common
= Include
= Source

4-24 Fri#uiH H 3T RSk
4.3.3. BCE TR H K4 A IR TN
N TG JEACRY RENS B IE A2 15, 7o 0 G PR A BRSO

TR AR E K S BERE Iy GCC L ABER)H LI, S51E Linux P55 H N
(IR A2 R TR SC— 30, AN BAMETE IR 4

W B g e 5 IE BRI P R T
B 7t Project Explorer /% hello_world Wi H, HiifbrAdE, % “Properties” .

B EFHAE O, B C/C++ Build 32, i “Setting” , 7EA4 MY Tool Settings £
HrhTicE .

B UK 4-25 fon, EH Target Processor, AR IZ/E N3o7, [KH R E 4% R Frn 4 ik
B EIEI, Zralin T,

® Architecture: %# RV32l.

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A WG 43
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® Multiply extension (RVM) : #i/4)i%k.

® Atomic extension (RVA) : F4Jik.

® Compressed extension (RVC) : F4)ifk.

® Integer API: i%&#¢ “ILP32” .

® Floting Point ABI: %#¥ single precision

® Codemodel: £ “Medium Any” .

A AR “Apply” 124 .

@ Properties for 2_helloworld

type filter text Settings
Resource
Builders
v C/C++ Build Configuration: Debug [ Active ]
Build Variabl«

Environment

Logging

® Tool Settings ® Toolchains M Devices O Container Settings # Build Steps

~ | ' Manage Configurations...

Build Artifact & Binary Parsers @ Error Parsers

I@ Target P rocessorIQ

& Optimization
& Warnings
& Debugging
® GNU RISC-V Cross Assembler
2 Preprocessor
% Includes
@ Warnings
3 Miscellaneous

Tool Chain Ec
C/C++ General
Linux Tools Path
MCU
Project Natures
Project Referenc
Run/Debug Seti
Task Repository

<

Task Tags ~ & GNU RISC-V Cross C Compiler
Validation (& Preprocessor
WikiText @2 Includes

2 Optimization
@2 Warnings
& Miscellaneous
~ ® GNU RISC-V Cross C++ Compiler
2 Preprocessor
% Includes
(2 Optimization
@ Warnings
& Miscellaneous
GNU RISC-V Cross C++ Linker
2 General
= Libraries
% Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
& General
~ ® GNU RISC-V Cross Create Listing
% General
GNU RISC-V Cross Print Size
¢ General

<
@

<
@

o

IArchitecture RV32I (-march=rv32i*)
Multiply extension (RVM)

Atomic extension (RVA)

Floating point Single precision extension (RVF)
Compressed extension (RVC)

Integer ABI ILP32 (-mabi=ilp32*)
Floating point ABI |Single precision (f)
ITuning Toolchain default

Code model Medium Any (-mcmodel=medany)

Small data limit |

Align Toolchain default (-mtune)

(] Small prologue/epilogue (-msave-restore)

Force string operations to call library functions (-mmemcpy)
] Allow use of PLTs (-mplt)

[ ] Floating-point divide/sqrt instructions (-mfdiv)

Other target flags ‘

Restore Defaults l Apply I
Apply and Close,

(4]

Cancel

K 4-25 fit & Target Processor i

B WA 4-26 fian, E&T “Optimization” , 2 M8 K& AR 2 i Bt & % 17 .

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA
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® Optimization Level: ##¢ Optimization Most (-02).
® (KIk)ik:

€ Function Sections (-ffunction-sections)

@ Data Sections (-fdata-sections)

€ No common unitialized (-fno-common)

e BIRIET NIE MK GCC 4 ki l, M BT AR GCC Tl 1 &
X

o BRI “Apply” &4

€ Properties for 2_helloworld O s
type filter text Settings Cvovy
Resource
Builders —
« C/C++ Build Configuration: |Debug [ Active] ~ Manage Configurations...
Build Variabl«

Environment Ny
® Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers

Logging
(1] 2 Target Processor © | Optimization Level Optimize more (-02) hd
Tool Chain Ec [wg [] Message length (-fmessage-length=0)
C_/C++ General 9Warmng.5 []'char is signed (-fsigned-char)
Linux Tools Path & Debugging Function sections (-ffunction-sections)
MCU ~ ® GNU RISC-V Cross Assembler . .
. Data sections (-fdata-sections)
Project Natures & Preprocessor No common unitialized (-fno-common)
Project Referenc @ Includes - . . .
Run/Debug Seti & Warnings [1Do not inline functions (-fno-inline-functions)
Task Repository & Miscellaneous [] Assume freestanding environment (-ffreestanding)
Task Tags ~ ® GNU RISC-V Cross C Compiler [] Disable builtin (-fno-builtin)
Validation & Preprocessor []Single precision constants (-fsingle-precision-constant)
WikiText @& Includes [] Position independent code (-fPIC)
@& Optimization [] Link-time optimizer (-flto)
& Warnings [] Disable loop invariant move (-fno-move-loop-invariants)
& Miscellaneous Other optimization flags ‘
~ ® GNU RISC-V Cross C++ Compiler

@3 Preprocessor
@2 Includes
@2 Optimization
¢ Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C++ Linker
& General
& Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
¢ General
~ ® GNU RISC-V Cross Create Listing
& General
~ ® GNU RISC-V Cross Print Size
& General

(4]

@ B Restore Defaults -
@ Apply and Close| Cancel

4-26 fid & Optimization &I

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA g 45
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B WA 4-27 i, % Debugging, 418 K b R 2) ik G B T,

® Debug Level: #£# Default (-g).

® Hlifi MR “Apply” %4

S50

@ Properties for myProj

type filter text Settings
Resource
Builders
~ C/C++ Build Configuration: Debug [Active ]
Build Variabl«

Environment

® Tool Settings # Toolchains M Devices O Container Settings # Build Steps

Build Artifact k@ Binary Parsers @ Error Parsers

~ | Manage Configurations...

Logging
[1] (% Target Processor 3]
ain Ec & Optimization

C/C++ General
Linux Tools Path
Mcu

Project Natures
Project Referenc

(2 Warnings
[ochugais] @
~ ® GNU RISC-V Cross Assembler
2 Preprocessor
& Includes
& Warnings
2 Miscellaneous

Run/Debug Setl
Task Repository

Task Tags ~ ® GNU RISC-V Cross C Compiler
Validation 2 Preprocessor
WikiText & Includes

& Optimization
2 Warnings
2 Miscellaneous
~ ® GNU RISC-V Cross C Linker
& General
& Libraries
2 Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image
¢ General
~ ® GNU RISC-V Cross Create Listing
& General
~ ® GNU RISC-V Cross Print Size
= General

Debug level Default (-g)

Debug format Toolchain default
[] Generate prof information (-p)

] Generate gprof information (-pg)

Other debugging flags ‘

[4)
Restore Defaults Apply

Apply and Close|

Cancel

K 4-27 fic & Debugging 1

B % GNU RISC-V Cross C Linker HJ General.

® N 4-28 Pw, RN D PR E BRI AS I I 7 A BERE A

& A EARINS L

& KA Rl “Workspace” 474 .

*

i3 5L 41146 I HummingBird ¥ 540, 7 LATT LU £ TLM. T #0Biont iR

gee_hbird_ilm.ld 0. 753 H % 4% $E NucleiStudio SO

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A
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nuclei_sdk/SoC/hbird/Board/hbird_eval/Source/GCC %
gee_hbird_ilm.1d SCfF. HAh MR ScE, S SCHELI A AR, \y
MR H OSBRSSl

® gcc_hbird_ilm.1d AR AR FAARRS B L) RAE ILM HIHBbEIX ], SMeERE R #
W B N EE MCU [ ILM A, M ILM JF 46347, ILM H SRAM 20 jik,
SpEER,

® gcc hbird_flash.ld HIAFE FFARIS B I BEHUIEZ0 3R Flash [X[H], KACRS BT
R REZ)HAE ILM (bl X 8], SR R 7 o B N #7E MCU 1)
Flash #, {H2 F 520l 5] # R PR AL Bikiz 2] ILM &, 28 )5 ) ILM
I LAPAT .

® gcc_hbird_flashxip.ld BIAFE PSR 2K Flash [X[8], &G TRH# B
FERHAE MCU [#) Flash #, JFE#: M\ Flash FFaHAT . BT HE 5 57E Flash
H, AsEBE IR,

o Pl E O RIERSIEMEHZIA . AT FiLE
gee_hbird_ilm.1d 1F iR .

& WETEIHREA AR “Apply” %4,

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A WG 47



R
NUCLEI

@ Properties for 2_helloworld

type filter text
Resource
Builders
v C/C++ Build
Build Variabl«

Tool Chain Ec
C/C++ General
Linux Tools Path
MCU
Project Natures
Project Referenc
Run/Debug Sett
Task Repository
Task Tags
Validation
WikiText

Settings

Configuration: Debug [Active ]

® Tool Settings ® Toolchains M Devices 0 Container Settings . Build Steps

<

<

<

<

<

& Target Processor

Script files (-T)

~ | Manage Configurations...

Build Artifact [ Binary Parsers @ Error Parsers

ol

& Optimization
& Warnings

& Debugging

B E) Add file path

File:

(7]
[ ok |

EFIVIISCenaneous
® GNU RISC-V Cross C Linker
oo
@ Libraries
& Miscellaneous
® GNU RISC-V Cross Create Flash Image
= General
® GNU RISC-V Cross Create Listing
% General

Cancel

(4]

| Workspace.. | | Fitesyster

® GNU RISC-V Cross Print Size
& General

[[] Do not use standard start files |
[1Do not use default libraries (-n(
["]No startup or default libs (-nos
Remove unused sections (-Xlin|
[ Print removed sections (-Xlinker

@ File selection O X
Select one or more Workspace Files
v & 2_helloworld A
& settings
= application
v & nuclei_sdk
& NMSIS
v & SoC
~ & hbird
~ = Board
v & hbird_eval
& Include
v = Source
v & GCC
[ gce_hbird_ddr.ld
gcc_hbird_flash.ld
gcc hbird flashxip.
[ openocd_hbird.cfg v
[6)
@ I OK ” Cancel ‘
--print-gc-sections)
(8]

K 4-

] Omit all symbol information (-s)

28 Mo B HERAA

Restore Defaults Apply

Apply and Close|

Cancel

B K 4-29 s, ZEFTRZIERCEIRI 20

Do not use standard start files (-nostartfiles) .

Remove unused sections (--gc-sections) .

M A T AR “Apply” 1424

VA

=
VEE:

R s T ) GCC B #1057 HAT A B GCC T 1 i X

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA -
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@ Properties for myProj O et
type filter text Settings S
Resource
Builders
« C/C++ Build Configuration: Debug [Active ] ~ |Manage Configurations...
Build Variable
Environment N . . = 5 g q 5 q
Logging ® Tool Settings ® Toolchains B Devices O Container Settings # Build Steps " Build Artifact @ Binary Parsers @ Error Parsers
Settings 2 Target Processor Script files (-T) 28 8
Tool Chain Ec (& Optimization "${workspace loc:/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Source/(
C/C++ General & Warnings
Linux Tools Path & Debugging
MCU ~ ® GNU RISC-V Cross Assembler
Project Natures 2 Preprocessor
Project Referenc 22 Includes
Run/Debug Setl ¢ Warnings
Task Repository 2 Miscellaneous
Task Tags ~ ® GNU RISC-V Cross C Compiler
Validation ( Preprocessor
WikiText & Includes

& Optimization
& Warnings
& Miscellaneous
~ & GNU RISC-V Cross C Linker
# General
& Libraries
2 Miscellaneous
& GNU RISC-V Cross Create Flash Image

<

% General
~ & GNU RISC-V Cross Create Listing < >
5
© ENGUEETSVS‘ Ve Print Si | Do not use standard start files (fnostartﬂ\es)l
v _
& General ross Frint Size Do not use default libraries (-nodefaultlibs)
[INo startup or default libs (-nostdlib)
|| Remove unused sections (-Xlinker ffgcfsedh)ns)l
L[ Print removed sections (-Xlinker --print-gc-sections)
] Omit all symbol information (-s)
< > Restore Defaults Apply

@ Apply and Close| Cancel

4-29 fi B 55421 General 170

B & 4-30 fizs, %A GNU RISC-V Cross C Linker [t Miscellaneous, % [#
Bic B e I .

rli% “Use newlib-nano” .

EIFT7R2)ik

%4 Hello World 25 11) Printf AN 75 4T EIVFE 2S5, FrCAAEE4)ik “Use float with

nano printf” .

Bt T AR “Apply” #H.

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA -
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@ Properties for myProj m| X
type filter text Settings LA
Resource
Builders
« C/C++ Build Configuration: Debug [Active ] ~ | Manage Configurations...
Build Variable
Environment - - . . . . . 7 5 g
Loaging % Tool Settings ® Toolchains B Devices 0 Container Settings # Build Steps Build Artifact & Binary Parsers @ Error Parsers
Settings = Target Processor Linker flags (-Xlinker [option]) £
Tool Chain Ec 2 Optimization
C/C++ General ¢ Warnings
Linux Tools Path ¢ Debugging
MCU v ® GNU RISC-V Cross Assembler
Project Natures 2 Preprocessor
Project Referenc 2 Includes
Run/Debug Sett @& Warnings
Task Repository (2 Miscellaneous
Tas_k Tags v ® GNU RISC-V Cross C Compiler Other objects )
Validation (2 Preprocessor
WikiText @ Includes
(2 Optimization
& Warnings
& Miscellaneous
v & GNU RISC-V Cross C Linker
(2 General
Libraries
v ® GNU RISC-V Cross Create Flash Image | Generate map ‘”!B{BuiIdArt\'fa(tFi\eBaseName}.map”
& General [ Cross reference (-Xlinker --cref)
v ® GNU RISC-V Cross Create Listing [ Print link map (-Xlinker --print-map)
& General [v] Use newlib-nano (Wspetsznano.specs)l
v ® GNURISC-V Cross Print Size L] Use float with nano printf (-u _printf float)
& General [JUse float with nano scanf (-u _scanf_float)
[[] Do not use syscalls (--specs=nosys.specs)
[]Verbose (-v)
Other linker flags ‘
= = Restore Defaults Apply
® [RopiyandGise] | Conce

K 4-30 A B 4E# 1) Miscellaneous &1

4.3.4. I B B K-S BN
N T BEE IR YW 7 nuclei_sdk SO BRSO, 7R BRI A0 AP IR B 1 H 06 B AR
A S
B WK 4-20 ffi7x, fE Project Explorer #9116 hello_world Bl H, sy Wbnt s, £
“Properties”
B EFHNEOF, BIF C/C++ Build 3, i “Setting” , 74 Tool Settings
Ho T &
B E 4-31 fli7n, % GNU RISC-V Cross C Assembler [¥] Includes, %8 B A~ fic B
BEA, PHWT.

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A W 50
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® 7t Include paths £ H ¥ i 4

® /B AE LT “Workspace” , i Folder selection 7 H .

® 7t Folder selection % 19 3E £ H i) nuclei_sdk H 3 ] NMSIS>Core>Include

PELTP
® A TS “Apply” SEHCLE

B CRA IR, HKIRESI nuclei_sdk H = T HYJ

SoC>hbird>Board>hbird_eval>Include, SoC>hbird>Common>Include
SoC>hbird>Common>Source>Stubs A4 J/E N &R, IR AR 78 GNU
RISC-V Cross C Compiler ] Includes £~ H & B A& %1% . WETEHSE RIS HUIE 4-32

B

(5]
type filter text Settings
Resource
Builders -
« C/C++ Build Configuration: Debug [ Active ]
Build Variable
E:;"";’:'“‘“”‘ ® Tool Settings  Toolchains M Devices O Container Settings  Build Steps
gging
Settings| € # Target Processor Include paths (-1)
Tool Chain Ec & Optimization
C/C++ General ® Warnings
Linux Tools Path & Debugging

MCu

Project Natures
Project Referenc
Run/Debug Sett

~ ® GNU RISC-V Cross Assembler
(& Preprocessor

|22 Includes] €

& Warnings

Task Repository @ Miscellaneous
Task Tags ~ ® GNU RISC-V Cross C Compiler
Validation (& Preprocessor Include system paths (-isystem) |
WikiText @ Includes
@
Directory:
(7] [4] ;
Cancel File system... =~ |
T wTerarn m
~ ® GNU RISC-V Cross Print Size
@ General
< >

~  Manage Configurations...

Build Artifact ki Binary Parsers & Error Parsers

o[}

L

Select one or more Workspace Folders

v &2 helloworld
settings
= application
~ & nuclei_sdk I
v = NMSIS H
v & Core

Cizgo

= SoC

Q
z

Cancel

15

Restare Defaults Apply
Apply and Close

Cancel

4-31 #% & GNU RISC-V Cross C Assembler ] Includes ¥ H 6.2 812

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA
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@ Properties for myProj O X
type filter text Settings vEYo
Resource
Builders
v C/C++ Build Configuration: |Debug [ Active ] ~ | 'Manage Configurations...
Build Variabl
Environment © - " . " . . . - .
Logging ® Tool Settings ® Toolchains B Devices O Container Settings # Build Steps " Build Artifact & Binary Parsers @ Error Parsers
Settings 2 Target Processor Include paths (-1) 28 85 &
Tool Chain Ec & Optimization
C/C++ General & Warnings "${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Board/hbird_eval/Include}
Linux Tools Path 2 Debugging "${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Common/Include}”
MCU « ® GNU RISC-V Cross Assembler *${workspace_loc:/${ProjName}/nuclei_sdk/SoC/hbird/Common/Source/Stubs}”
Project Natures (2 Preprocessor
Project Referenc
Run/Debug Sett & Warnings
Task Repository & Miscellaneous < >
Task Tags ~ & GNU RISC-V Cross C Compiler -
Validation = Preprocessor Include system paths (-isystem) L=
WikiText
& Optimization
¢ Warnings
¢ Miscellaneous
v ® GNU RISC-V Cross C Linker
¢ General
¢ Libraries
& Miscellaneous
~ ® GNU RISC-V Cross Create Flash Image Include files (-include) )
& General
~ ® GNU RISC-V Cross Create Listing
¢ General
v ® GNU RISC-V Cross Print Size
¢ General
< > Restore Defaults Apply

4-32 % # GNU RISC-V Cross C Compiler ) Includes = H & #4%

4.4. ETSHK Makefile 8185 B

KA A G a8 F ©45 1) Makefile 7E Nuclei Studio IDE 6% —/Mii [l Makefile [¥] Hello
World i H . H &N HummingBird Evaluation Board, W%~ N307. 155G # Nuclei
SDK, Github ##A: https://github.com/Nuclei-Software/nuclei-sdk. %5 7 G120 H 2
bb, EHFEFFRESFIEDARE, X5 helloworld i, AP,

4.4.1. FHHEHH

SRR kS “File—> New —> Makefile Project with Existing Code” . & 4-33 AT

7o

WIE 4-34 Fis, TEEGS 1 AN TR, X A6 48 nuclei-sdk. 7EElfx 2 4b%i A\ SDK
FISZPRERAE . 72 BFR 3 Abik$E “RISC-V Cross GCC” o i bR 4 58 B &I H .

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 52
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@ CPDE - NucleiStudio

- [=} ®
fFilcJedit_Source Refoctor Mavigate Search Project Run RV-Tools Window Help
New Alt+Shift+N > |~ Makefile Project with Exis GriHrOThrUriSE g, chrmara Quick Access| || =
Open File. T O/t e s Projec] .
o Project.. £ Outline
2 Open Projects from File System..
Recent Files » © Converttoa C/C+ + Autotools Project An outline is not available.
= ., ComverttoaC/Cs s Project (Adds C/C++ Nature)
o= CUEWE g source Folder
Close All ClShift+W ¢35 Folder
Cirlss € Source File
W Header File
Ctrlsshiftss O File from Template
@ Class
= Task
[y T Example.
£ 5 T Other CtrlsN
Convert Line Delimiters To >
Print. Ctrle P
= Import.
Expart.
Properties AltsEnter
Switch Workspace >
Restart

Exit

! DConsole T Propert
Mo consoles 1o display at this time.

4-33 i T Makefile 1) LHE

@ New Project | X

Import Existing Code

Create a new Makefile project from existing code in that same directory

Project Name Q
Inucleifsdk I ‘

Existing Code Location (2]
I CAUsers\24954\Desktop\nuclei-sdk ‘ Browse... I

Languages
Cv]|C++

Toolchain for Indexer Settings

<none>
Cross GCC

NU Aytotog oolchain 6
RISC-V Cross GCC

Show only available toolchains that support this platform

Y

W’

°

K 4-34 i E TRk

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7 WG 53
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4.4.2. % B Makefile B42#1 Build £

A R THRE, 1&FE “Properties” fTH R E UL, 1K 4-35, E&#HF “C/C++ Build” ,
7f “Build Location” Hi&$Ft “Workspace” . 7E54 Hi 3% ik $ “application —> baremetal
—> helloworld” gidi “OK” fid “Apply” fR1F.

@

type filter text
Resource
Builders

C/C++ Build]| @ Configuration: Default [ Active]

C/C++ General
Linux Tools Path
MCU

Project Natures
Project Referenc
Run/Debug Seti
Task Repository
Task Tags
Validation
WikiText

C/C++ Build

[l Builder Settings @ Behavior < Refresh Policy
Builder

Builder type:
Use default build command

External builder

Build command: ${(rossimake} Variables...

Makefile generation

[ ] Generate Makefiles automatically Expand Env. Variable Refs in Makefiles

Build location

Build directory: |$|work5pacejo(:]nudeifsdk,/app\ ication/baremetal/helloworld} ‘

File system...| Variables...
[2]

(5]

~ | Manage Configurations...

Restore Defaultsl Apply I

Cancel

Apply and Close

L

Select a folder from workspace:

v & nuclei-sdk A~
&.c
= settings
~ = application
v = baremetal
& benchmark
= demo_dsp
= demo_eclic
= demo timer
- Eelowors]©
g main.c
& Makefile
= freertos
& rtthread
& ucosii
= board-labs
¢ Build
= doc
= NMSIS

Kl 4-35 i & Makefile #%4%

WK 4-36, £ “C/C++ Build” #1ik# “Behavior” #:H, #iff2)i% “Build (Incremental
Build) 7 &I “all CORE=n307 DOWNLOAD=ilm” . ' “CORE” %R HE 52 Pri Py

A, X B LA ngo7 AH.

“DOWNLOAD” &I A] MEEAF I R 3, 4S5 4.1

1, X HELLilm A . D BIFE#E B HummingBird Evaluation Board, JitLA SoC #1 Board
A BB, 0BG HAm T & #, DL RVSTAR Jofil, % 7E b v B 1 n “ SOC=gd3avfios
BOARD=gd32vfio3v_rvstar” , Jf HH T RVSTAR {37 ff FLASHXIP #3(, 724
“DOWNLOAD” ¥ & N “flashxip” , [ “CORE” &2~ “n205” . 5eiJa fidi “Apply”

RAFB

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A
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&) Properties for nuclei-sdk | X
type filter text C/C++ Build e

Resource

Builders

C/C++ Build] @ Configuration: Default [ Active] ~ | Manage Configurations...

C/C++ General (2]

Linux Tools Path = n

I\‘/Ir:iuL)J( oolsta EEl Builder Setting““ Refresh Policy

Project Natures Build settings

Project Referenc Stop on first build error []Enable parallel build

Run/Debug Set Use optimal jobs (8)

Task Repository Use parallel jobs: 8 =

Task Tags Use unlimited jobs

Va-\ifjation Workbench Build Behavior

WikiText Workbench build type: Make build target:
[1Build on resource save (Auto build) all Variables...
Note: See Worki)ench automatic build preference

OI Build (Incremental build) ‘a\l CORE=n307 DOWNLOAD=ilm ‘ Variables... I
Clean ‘(Iean ‘ Variables...
(4]
< > Restore Defaults I Apply I
@ Apply and Close Cancel

4-36 fic & Build &1

FEFER LR RAE ), ITOT TR E T, | 4-36, #HETEE, i “Apply” RAF1E

e

ARSCAF TR N AR IS RS BHSOIGIT A, R SRR T IRARAL, AL, Sl A 2 it 7 i

P

N
o
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| Settings

Run/Debug Settings

Task Repository Cr+ compiler: [g++

Canfiguration: Default [ Active ] ¥ Manage Configurations...
& Toolchains Binary Parsers @ Error Parsers
Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc) |
Architecture: | RISC-V v ‘
Prefix: [riscv-nuclei-eli- |
Suffic [ |
Project References Coompiler:  [gee ‘
Warning: these definitions do not affect the build and are for the benefit of the inde

Task Tags
Validation |
WikiText |Tu0\:hain path: [${eclipse_homej\toclchain\geeibin |

fio shang it uss the alobal or workspace preferences pages or the argicit proper

IBuiId tocls path: [${eclipse_homel\taclchain\build-tacls\bin |

to change it use the global or workspace preferences pages or the project proper

Restore Defaults Apply
@ Apply and Close]|| cancel

Kl 4-37 BCE THEEHS

G PEIZAT DL I A RIES % 5. 6 o

5. %%FmHE
5.1. Nuclei SDK THE#ETH

7t Nuclei Studio H 7] LA i Nuclei SDK T2 B T. A —## & Ui id Nuclei SDK Project
Wizard 62 1) TR SERE T . AT AASCRTRR T8 ZKI B MET Makefile €
BIBE . TEANE AP IR IR

Fhi h FH B TR, Z 5B 5-1 §7JF RV-Tools>SDK Configuration Tools, 7] PAfT
THE g FIE TR E . ] LA EE MR TS, WE 5-2, A TAAKN TEEE T AR

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 56
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Fro BRFEBGHEBNN TG, 88I%T ctrl+6. W DA HEENN TEE, WK 5-3, A
A, %% SDK Configuration Tools. W& 5-4 N LFERE T HEME, SEIEAD6EE

.

projectName 4 {7+ 1) TFE % .

Configuration Core A 4HT LEEXT R NZ. HT TR ARCH A1 ABI 3% I #E Hi x0T
IR, TASFI P A% AT BE A AR IR ARCH A ABT 3EI0, T LA R LAl BE 2 AT il
7%, RE ARCH 5 ABI N IEHERD AT . e I0A 5 5 PR U] 48 P A% 3 DA A

ARCH X ) 2457 TR arch £,
ABI XM 2475 TFEH abi &0 .

Download W 2457 TAER Faia, Al AVIHGR AR FEH, B ariUs S AR
YEHIH T EBLR, RVSTAR U FLASHXIP #izt,

NewLIB X 3 (113 Hf NEWLIB /. #J LAGE ¢/ 7548 H nano &, & S48 ¥ AT E
Optimization Level X} 4 B A4 55 2

Extra Common Flags % B (] /2 # 4 M s F g i . AT DA DA A1 )38 FH 9 3 126 10
Extra C Flags %t S F2Z4MF) C ik Il. n] LAESINZR AL C gk Il .

Extra C++ Flags Xf M. [ 2/ MP) C++uiie . AT LAV INZSM 1) CH+ 2 PR T
Extra ASM Flags % I [ & BV G 2 e T AT LIS INA AT 9120 2 126 701

Extra Link Flags XJ M ()2 8 BRI, e 1 O 4047 BRAE T HL 75 2239 0 4
PRI, AT AFE S PR OT Sk BRGs R AR AR R — > 25 M - RIS 0 4 i 100

MRa s B A ERET, X BN MBS & 09-0s P BT HAT SO RN sl
save B IFILT, ZJFMWE 5-5, AL BSURN TR A RAR, L#H “Clean
Project” #&H—F TR, il 1 ElIbs B AT 58 S o B 00 B84 19 RS

AT A A REAC SRR A, RESKBECRETHRE, AR, S A 2 iR aidE 7 A g 57
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@ CPDE - NucleiStudio

File Edit Source Refactor Navigate Search Project Runf RV-Tools |Window Help
%|[0][®]/0Run = hello_world_debug ¢ @ SDK Configuration Tools 6 fvdvovinvOovhvAvios sy Bl

& Project Explorer
~ 55 hello_world
& Includes
= application
= nuclei_sdk
hello_world_debug_openocd launch

@ CPDE - NucleiStudio

Nuclel System Technology Homepage
Nuclei SDK Documentation
NMSIS Documentation

£ Problems < Tasks © Console  ©lProperties & Terminal
GNU MCU Eclipse Packs console

Completed in 3ms.

No installed packages.

Completed in 3ms.

2020-08-06 11:13:08
Extracting devices & boards. ..
No installed package
Completed in 2ms.

B 5-1 $THE el BRI & 1

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[0][=] ©Run +| @1 _helloworld debug_~ | S ¥ srq-as-onss@a-erererero-avarize

& Project Explorer & a%le =1
v = 1_helloworld

& Binaries

¥ Includes

= application

& Debug

& nuclei_sdk

1_helloworld_debug_openocd launch

1 helloworld

Probler Tacks @ Console » nal
CDT Build Console [1_helloworld]

5-2 FTIHE g L 5 B 2

& Outline k

An outline is not available.

E Qutline Buil r

An outline is not available.

= a X

Quick Access|: ¢
- s x
|Quick Access||| = | [

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7
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@ CPDE - NucleiStudio

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4|0 [=| ORun 11 _helloworld_debug_~

& Project Explorer = a
~ &1 helloworld
 Binaries New
# Includes Go Into
& application Openin New Window
& Debug .
= nuclel sdk Show in Local Terminal
1_helloworld_debi © Copy

Paste

Rename.
= Import.
“ Export.
Build Project
Clean Project
Refresh
Clase Project
Close Unrelated Project
Build Targets
Index
Build Configurations

Profiling Tools
Validate

© RunAs

# Debug As
Profile As

Restore from Local History.

Ctrl+Alt+Shift+Down

LRSS R al-1aY L MR R

5

Ctrl+C
Ctrl+V

Delete

3

F2

@ SDK Configuration Toolks

Ctri+6

T Ton /0 + Code Analyer
Team
Compare With
Configure
Source

Properties

Alt+Enter

1 helloworld

@ T HETOTR AN 4

B 5-3 THE s BRIE I & 3

@ Nuclei SDK Project Configuration

projectName

Configuration :

Core:

ARCH

ABI:
Download :
NewlLIB :

Optimization Level :

Extra Common Flags
Extra C Flags

Extra C++ Flags
Extra ASM Flags
Extra Link Flags

Save

: 1 _helloworld

Debug v
N600F v

: ‘r\.'32Tmafc |
ilp32f |
ILM >

None(-00)

newlib-nano without print float ~

o

SDK Configuration Tools:1.0.0.0

Cancel

www.nucleisys.com

5-4 —HRAE g LI

? B Qutline

An outline is not available.

Qui

s} *

ick Access| || = | B

Tl Ra=kd
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@ CPDE - NucleiStudio - [« ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
U - @1 1_helloworld_debug [l g Br&{v i @vOin WP EvEr v I T HETOTOYQAYIAS g - - & - - \Quick Access| | =8| &
ot Explorer 1 £ Outline
v Sk orld
g e D An outline is not available.
Go Into
Open in New Window
nuclel_sdk Show in Local Terminal
1_helloworld de
- - Chri+C
t trl+V
Delete
move from Cc hift+ Dowr
ource
ename... F2
ort...
xport...
uild Project
| Clean Project | ©
™
lose Project
Ur d Pr
Build Targets =
Index
Build Configurations
Profiling Tools
Validate
© RunAs
t Debug As
Profile As
Restore from Local History..
ctil+6
Properties Alt+Enter

1 helloworld

Bl 5-5 JiE BRI OB i LR

TEE R R W R Y TREM 32 A28 64 f7, FTESTH AR REH, W 6-6, &K
“command” H' “set arch riscvirv32” N “set arch riscv:irvoq” , M 64 S Y)H[a] 32 7 )W 24
X H R Z 50 R EUE -

5.2. 7E Nuclei Studio 945+ Hello World i H
7E Nuclei Studio HZmEH PRI .

By UREGER N, @ISR BHEE . WK 5-6 s, {E Project Explorer £ H1 ik H
hello_world B H , i fbrtitE, %E#E “Clean Project” .

B 1K 5-7 o, B EREE TR, TR H BT . AR PR, RN
K s-7 R, BERSE BIAE BT HAT SCEFIOARADARFAR /I, B4 text B, data BUHI bss
B, LA/ bR RS BE R UE . 8 Makefile 77 0B 1 TF2 75 ZE7E A B2
Frhi% Pk “Build Project” #4740 .
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@ CPDE - NucleiStudio - [« ®
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
A//0/[m] ORun ~ @ hello_world_debug o~ (=8 LRSS R al-1aY WP ETETLTEITIHETOTO YA Sy rhHvGGra - [Quick Access| ;| & | &

& Project Explorer = Bl =
© 5 helln werid
o1 New > An outline is not available.
=i Golnto
&1

Outline = ok 2

©Open in New Window
Show in Local Terminal >
Copy
Paste

x Delete
Remove from Context
Source >
M
Rename... F2

Import.
4 Export.

Build Project

l Clean Pro)
Refresh S
Close Project

Close Unrelated Project

Build Targets >
Index >
Build Configurations >
Profiling Tools >
Validate
© RunAs >
% Debug As >
Profile As >
Restore from Local History...
© SDK Configuration Tools Cirive
% Run C/C++ Cade Analysis
Team > lems & Tasks @ Console ties & a o =
Compare With > | GNUMCU Eclipse Packs console
o .| completed in 3ms. ~
Sl [0 Mo installed packages.
Source | Completsd in 3ms.
Properties Alt+Enter 2620-08-05 11:13:08
Extracting devices & boards...
Ho installed packages.
Completed in 2ms.
% hello world =
[A] o ¥ Y “ A ”
5-6 %} hello_world T Clean Project
@ CPDE - NucleiStudio - [« ®

le

dit Source Refactor Navigate Search Project Run RV-Tools Window Help

O |®m| ORun ~ @ hello_world_debug o~ (=8 LRSS R al-1aY WP ETETLTEITHETOTOA YA Sy rhHryGGra - |Quick Access| ;| & | &

& Project Explorer
~ & hello_world
 Binaries An outline is not avallable.
# Includes
& application
& Debug
& nuclel sdk
hello_world_debug_openocel launch

Outline = K k.

lems sks @ Console T
CDT Build Console [hello world]
AOVOKINE: LU KISL-T L

2
[riscv-nuclei-elf-size --format=berkeley "hello_world.elf"
o text data bss dec hex filename

7732 112 229¢ 10134 2796 hello_world.elf
[Finished building: hello_world.siz

11:40:18 Build Finished. @ errors, @ warnings. (took 3s.655ms)

5 hello world =

& 5-7 BT EARA hello_world T H #4742
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G ) e T LA BN T Debug SCAFSk, Wl 5-8, & SCAFEINT

B hello_world.elf /&4 B A 04T 30

B hello_world.hex & ) Hex 3 ff.

®  hello_world.Ist 242 s ) list SO, w] A 21 s I g AT SR (0 AR 0 B 45 12

B hello_world.map 242 5% map SCHF, 7 BLVELH & 2 A e ARRS 20 A 1 L

@ CPDE - hello_world/Debug/hello_world Ist - NucleiStudio ul
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
4//0 =] ORun @ hello_world_debug ¢ ov Bviva®v O 2P A TE YL@ H YOO S G e i - - Juick Access
hello_world.Ist ©* i hello_world.map Outline
223 .weak eclic_irq5@_handler
An outline is not available.
vector_base

r_base:
lefined(DOWNLOAD_MODE) && (DOWNLOAD_MODE |= DOWNLOAD_MODE_FLASH)

j _start /* @: Reserved, Jump to _start when reset for ILM/FlashXIP mode.*/

80000000:  1980006F j 80000198 <_start>
e 80000004 CEE unimp
elf - [none/le] 231 30000006: 0800 unimp

232 80000008 : 8532 s1li 20,28, 0xc
8000000a: 8000 ex8e0e
8000000c: 0090 unimp
8000000e: 0000 unimp

80000010: 8532 s1li 20,20,0xc
80000012: 8000 ox8000

T 80000020: 532 s1li  a8,3e,8xc
= 240 80000022: 8000 ox8eee
hello_world_debug_openocd launch 241 50000624: 0000 undinp
2 80000026 0000 unimp

80000028 : 8532 slli 0,20, 0xc
80000023 : 8000 exseed
8000002¢ : 2000 unimp
8000002e: 0000 unimp

© Console > ki@ vy

CDT Build Console [hello_world]

5| Writable Insert 11

5-8 A A A ST

6. WA E/TIE
6.1. &S ARIESE S OpenOCD HiRiZ/TH B
6.1.1. s 5 A X E)

Nuclei Studio [ 2021.02 it #2 openocd 523 windows % BRIl fg, d kA & BL |
windows P& AT Y, Linux AN TR BCE BN KT A P s 4 UL 77
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GAEIRES
6.1.1.17E Windows &% 3Bz,

PR GRS, T LSRR R 25 FPGA IR R ARE 7. 5 5el IR 547 55 £ L PC
HEATYERE, SSIRUIF.

BRI SRS 0 gl N AL PC W USB #1001, 7 —ui 5RBIF RARERE: . R iR
FE U AE S S R8s, N T B ENL PC 1 Windows £ 4t AEMS 1R 74 1 1R 25 11
USB, #2358 0Kk3), Xk uiE 1-2 fin i) NucleiStudio IDE SC4H6L A1) HBird-
Driver.exe R A 58 St 3K 5] () 22 256

B TSRS S T R R RIT AR  tH ) UART #40 USB” 1JZhfE, BRItk
i S A A AL PC IR Ty (HAKEN AR ), M2 s g EHLIR A N — A
COM # I,

® UK 6-1 Fian, 7EFENL PC I A BSR40 (COM F1 LPT) £~ H”Hu] D&
HF)i% COM [ 15 (241 COM11) -

® b IR )R SEMIRE Frig AT I R ok 78 24 R AT A AGS AT RE Fr 1Y printf 4t B 2 1.
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& REEES - a X
HHF)  IBEA)  EBNY)  #EH)
e m Hm B

v % DESKTOP-V8C6817 B
= IDE ATA/ATAP| #2428
Iy z2wE
O a2
- HEARENER
S TERERRIES
=0 TENRASY
P wits

v @ _#0 (COM F LPT;
|ﬁ USB Serial Port (COM11)I
¥ &4
0 3550
O ines
==
0 =7
) AREARE
i %iHgs
B srida
i FE. JREEEGIEE
0 BiFnEftsHHES
§ ERETRERE
§ EASTR%ieE
B RRIERLS
in ZiRE
I BREERE
=TT ¥

K 6-1 fEi & & &) COM H %5

R Al e IREEE T N, FHEER LI i Windows [IERRIRG, S
58 (bR ok RN AT HH BT IR IE A Hb 223 T HBird-Driver.exe [3K5)), HBBH7E 15 & & 145 ik 2
COM M %5,

6.1.1.27 Linux R4 LRI
{E Linux 755 N 23030 R R -

B 1 B KRRE Linux B, #f% USB 4% Linux iR5 k. S8 H gL, e 6-2,
WORTT R AGER] T BRI

W2 fEEHIG P susb I8 EEE L, SHENITHELLT:

Bus 001 Device 010: ID 0403:6010 Future Technology Devices International, Ltd

FT2232xxxx
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B 3. &SP %iN sudo vi /ete/udev/rules.d/99-openocd.rules 15447 99-
openocd.rules 3L, HIAWTHNE, RIFEH

SUBSYSTEM=="usb", ATTR{idVendor}=="0403",

ATTR{idProduct}=="6010", MODE="664", GROUP="plugdev"

SUBSYSTEM=="tty", ATTRS{idVendor}=="0403",

ATTRS{idProduct}=="6010", MODE="664", GROUP="plugdev"
B4 WP EERLE Linux 2400

B 5. {#H1s /dev/ttyUSB*fn & & E ttyUSB 5 E., %ML F: /dev/ttyUSBo
/dev/ttyUSB1

B 6: {fiH]1s-1/dev/ttyUSB1 in 2 &H M AEE, SHEHmBUIT: crw-rw-r-- 1 root plugdev
188, 1 Nov 28 12:53 /dev/ttyUSB1

Al LLE F ttyUSB1 LA M plugdev A, £ T RIATEN B O3] plugdev 20 (A A
WA REAL T, IR SLBRIENIEND - i/ whoami iy & &E UATH 4, A

¥ HAC T N < your_user_name >.

B 7. {#if] sudo usermod -a -G plugdev <your_user_name>fiy ¥ H C.i M1 plugdev
4.,

B 8: FIRMMIAMETH A E)E T plugdev 41, f#H groups 4, W UEFIFEMEE+FH
plugdev BRI ER I 2410 FH P s D 2 plugdev 4H. @S EA T LLEARE S .

AT A A REAC SRR A, RESKBECRETHRE, AR, S A 2 iR aidE 7 A g 65
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ISR = NN

Kl 6-2 JFRBUER: 2 EUALH

6.1.2. ¥ A. B Debug Configuration
il Nuclei Studio #7# J#lit & Debug Configuration W& HI5 40T .
B 0IE 6-3 Fun, TERHEAHER “Run—>Debug Configurations” .

B 1K 6-4 n, fEFRIAE EH, WURBCA S TR IR E NS, Asd “GDB
OpenOCD Debugging” , #%# “New” , K2 WA H #rdH — NMEAIH
“hello_world_demo Debug” , WK 6-5 firn. itk “Project” & 2480775 Z RN L
e, “C/C++ Application” k¥ | 1E#A 75 21 ELF 3.

B E 6-6 fTas, EFHKIE “hello_world_demo Debug” [¥) Debugger S 5., 7£
Config options % H HH3H N\ -f
"nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd _hbird.cfg", VIi{x OpenOCD fif
FIER R B . X B C B SO
(nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cfg) i #&szkx T
openocd MIFC B LA EEARTIE . Flhn: WA makefile 770 F AN THE, BXubabrin
2 N-f “SoC/hbird/Board/hbird_eval/openocd_hbird.cfg”.

5 YR N A% 2 RISC-V 32 AL N#%, iEHifF Commands &7 set arch riscv:rv32

R MHTNAZ AN 64 11, MR A set arch riscv:rvé4
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B E 6-7 fis, EFERIE “hello_world_demo Debug” ] Startup 325, Hiff
“Debugin RAM” , “Pre-run/Restart reset” , “Set Breakpoint at Main” #/
“Continue” #2i%k.

B 6-7, SERJESEHA T “Apply” PRAFIRE .

@ CPDE - NucleiStudio

- o X
File Edit Source Refactor Navigate Search Project Rum RV-Tools Window Help
&|[0][m] ORun @1 _helloworld_debug_ ® Run Cr+Fll g vy v @rbvO v vQri®s v rHrtErD Quick Access| || = | &
—— = Debug | = )
& Project Explorer © 8 @ Profile £ Qutline
« 1 helloworld
& Includes Profile Histary > An outling is not available.
application Profile As E
Debug Profile Configurations...
nuclei_sdk Run History B
1_helloworld_debug openocd Jaunch N
| Run Configurations... |
Debug History >
% Debug As >
Debug Configurations.
Breakpoint Types >
Toggle Breakpoint Ctrl+Shift+8
Line Breakpaint
Ctrl+Alt+B
>
O Console # Ten 2 k=@~

DT Build Console [1_helloworld]

21:37:11 **** Clean-only build of configuration Debug for project 1_helloworld ****

make clean

rm -rf ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/close.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/fstat.o ./nuclei_sdk/SoC/hbird/Common/Source/Stubs/gettimeofday.o ./nuclei_sdk/SoC/hbi

21:37:11 Build Finished. @ errors, © warnings. (took 171ms)

1 helloworld

6-3 #.ii “Run Configuration” #t47 F#k
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@ Run Configurations | X
Create, manage, and run configurations @
CEeEX B3~

Configure launch settings from this dialog:

type filter text | - Press the "New Configuration’ button to create a configuration of the selected type.

£ Build Docker Image  ~

] C/C++ Application .
1 C/C++ Container Lau | ™ Press the ‘Export’ button to export the selected configurations.

- Press the '"New Prototype’ button to create...onfiguration prototype of the selected type.

€1 C/C++ Remote Appl | [ - Press the 'Duplicate’ button to copy the selected configuration.
¢ C/C++ Unit

% - Press the 'Delete’ button to remove the selected configuration.
© Docker Compose

Riabiibombilamlustantaconfigure filtering options.
v [E1GDB OpenOCD DY New Configuration ) o
E hello world det™=™ New Prototype uration by selecting it.
€1 GDB PyOCD Debur .5 Export... nd then se..nk Prototype’ menu item to link a prototype.

E1GDB QEMU Debuc — Duplicate

1 GDB SEGGER J-Linl i Delete

@ Launch Group i Link Prototype...
# Launch Group (Dej , njink Prototype

Launch over Serial | Racet with Prototype Values tings from the 'Perspectives’ preference page.
& Run Docker Image
< >

Filter matched 15 of 15 iter

nd then se... Prototype’ menu item to unlink a prototype.

nd then se...s" menu item to reset with prototype values.

@ Run Close

6-4 7 n¥ 1 GDB OpenOCD Debugging

@ Run Configurations O x
Create, manage, and run configurations ‘ ii
¥ @ x C

Name: hello world_debug_openocd

type filter text
Build Docker Image
[© C/C++ Application
& C/C++ Container Launcher

(1 Main , # Debugger| & Startup| - Source | Common| % SVD Path

Browse...
€ C/C++ Remote Application C/C++ Application:
o g"c” 'Lé““ Debug/hello_world.elf
0 Docker Compose
~ [ GDB OpenOCD Debugging Variables.. | Search Project... Browse...
&l hello_world_debug_openocd Build (if required) before launching
E1GDB PyOCD Debugging Build Configuration: Select Automatically o
[ GDB QEMU Debugging _ -
%1 GDB SEGGER J-Link Debugging () Enable auto build () Disable auto build
& Launch Group (®) Use workspace settings Configure Workspace Settings.
# Launch Group (Deprecated)
Launch over Serial
4 Run Docker Image
Filter matched 15 of 18 items Revert Apply

6-5 GDB OpenOCD Debugging #:H T hello_world 5i H Debug
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€ Run Configurations

and run

Create,

ErEX B®R~
type filter text
@ Build Docker Image
C/C++ Application
€ C/C++ Container Launcher
© C/C++ Remote Application
€1 C/C++ Unit
© Docker Compose
© GDB OpenOCD Debugging
© hello_world_debug_openocd
& GDB PyOCD Debugging
© GDB QEMU Debugging
© GDB SEGGER J-Link Debugging
& Launch Group
# Launch Group (Deprecated)
Launch over Serial
@ Run Docker Image

<

< >
Filter matched 15 of 18 items

@

Name: ‘ hello_world_debug_openocd

© Main | $ Debugger > Startup| & Source| = Common % SVD Path
OpenOCD Setup

Start OpenOCD locally

Executable path: | ${openocd_path}/${openocd_executable}

| Browse... Variables..

Actual executable: C:\Users\24954\Desktop\NucleiStudio | DE}DZGOB\Nu(IeiStudiuilDEﬁZﬂZUDB\Nu(leiSIudin\\lDl
(to change it use the global or workspace preferences pages or the project properties page)

GDB port: [3333 |

Telnet port: 4444

Tel port: 6666

Config options: [ nuclei_sdk/SoC/hbird/Board/hbird_eval/openocd_hbird.cig]

Allocate console for OpenOCD

GDB Client Setup
Start GDB session

Executable name: | ${cross_prefixjgdb${cross_suffix}

Allocate console for the telnet connection

| Browse... Variables..

Actual executable: riscv-nuclei-elf-gdb |

Other options: |
Commands: set remotetimeout 250 A

set arch riscvrv32 "
Remote Target

Host name or IP address: localhost
Port number: 3333

["] Force thread list update on suspend

Revert Apply

Cie

X

6-6 it & hello_world_demo Debug 2% 1

@ Run Configurations =] ®
|
| Create, manage, and run configurations (i
BRBNIER Name: hello_world_debug_openocd
type filter text I Main % Debugger » Startup - Source = Common = SVD Path
B:é'd Dg"‘jﬁ "‘:_a?e Initialization Commands
++ Application -
/C++ Container Launche | LJnitial Reset. Type: ini
= C/C++ Remote Applicatic.
© C/CH+ Unit
© Docker Compose -
Enable ARM semihosti
+ /GDB OpenOCD Debuggin| | £01e ARM semihosting
= hello_world_debug_ops | L0ad Symbals and Executable
7 GDB PyOCD Debugging | [] Load symbols
1GDB QEMU Debugging ® Use project binary: hello_ world.elf
1GDB SEGGER J-Link Debuc| () Use file: Workspace File System.
 Launch Group
& Launch Group (Deprecate,| >YMBels offset (hex):
Launch over Serial e
& Run Docker Image ®) Use project binary: hello world.elf
©) Use file: Workspace_.  File System_
Executable offset (hex):
Runtime Options
Debug in RAM
Run/Restart Commands
Pre-run/Restart reset Type: halt|(always executed at Restart)|
[ set program counter at (hex):
[]Set breakpoint at: main
Continue
Restore defaults
< >
Filter matched 15 of 19 items Revert Apply
2 e

6-7 fic & hello_world_demo Debug )&% 2
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6.1.3. 7 JRATT Rk iR ERF
SRR LR R/, 7 Z ST O LME M S Printf e& BT EHIE B .
i ) Windows #GeH] I 8 LFJ5VELTT

B §TJF Nuclei Studio H 55 DT EI@E, %4 Window>Show View>Terminal, 1
6-8 i, RN BIFRT IR N EE . Wl 6-9 fx, EHE L E Choose
terminal CiEFEH 0, HJ Serial Terminal) . “H 105”7 GXHELPL COM11 A « “P
B (KB N115200) 7 ES55, #ii “OK” #4.

8 CPDE - NucleiStudio

- o x
File Edit Source Refactor Navigate Search Project Run RV—IUUIsHeIp
%][0][®] ©Run @l hello_world_debug o o~ New Window hewdia-e-dr6rit-0-a-rizcs~ * Acce
& Project Explorer 3 ’ 1 & Qutline
~ & hel
r An outline is not avallable.
Alt+Shift+Q, €
nuclei_sdk Inclu
hello world_debug openocd launch avi
utli Alt+Shift+Q, O
rab
rol Alt+Shift+0, X
roje
oj
earct Alt+Shift+@, s
as| Alt+Shift+Q, K
2 Tasks
|-;' Terminal | o
Other. AltShift+Q, Q a
£ Problems # Tasks ©Console [ Properties & Terminal : (=] ]

K 6-8 iEit Nuclei Studio T & DR F AL E S H
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@) Launch Terminal U X

Choose terminal: Serial Terminal ™
Settings
Serial port: [COM11 v
Baud rate: 115200 ™
Data size: 8 >
Parity: None ™
Stop bits: |1 >
Encoding:  Default (ISO-8859-1) &7

@ Cancel

6-9 WHEF O
i Linux 2G5 D750 :

B fTJF Nuclei Studio H 7 f) Terminal ¥, 1%+ Window>Show View>Terminal, 41/
6-8 firan, s Eonas BAsIT o i Bk, W&l 6-10 Fizn, choose terminal 4%
Local Terminal, i OK ] JF Terminal &3, W& 6-11 ffi7x, HA “minicom
/dev/ttyUSB1115200” #THFH [, BITA[4E Nuclei Studio & & & T EHIE & .

B Launch Terminal

Choose terminal: | Local Terminal -
Settings

Encoding: | UTF-8 M
® Cancel OK
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6-10 #TFF Terminal 2

& hbird (ubuntu) 2

Welcome to minicom 2.7

OPTIONS: I18n

Compiled on Mov 15 2018, 20:18:47.
Port /dew/ttyUSBl, 14:38:85

Press CTRL-A Z for help on special keys

CTRL-A Z for help | 115288

8N1 | NOR | Minicom 2.7 | VT182 | Offline | ttyUSB1

K 6-11 47

0 SRR G R RS 47T U MR Y, 7T LU Nucled Studio TDE HEAT .
tF IDE 247 FE 4L PC 3, MTFERHEAT TR R0 L, FULSA I Ay “ 4R ok
# LR

X B DL 1_helloworld ~#%1, {# ] Nuclei Studio IDE %} HummingBird SoC J& B! I &t i 47
LRI BU T

B iR 6.2 1911 Debug W E N IEHE, LTI Debug S ELHAIA. WA 6-12 JIr
/~, {E 1_helloworld T4, &4 “Debug As —>Debug Configuration” 477F
Debug ¥ & U i £ 2 7 Hr g 1) W BT A

|

WEREIRE, £ 6-13 B T HiEikt Debug, )54 MK N H RUEbR, B
BRI RE AT A ZOF N AL Pt A TR AR o
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€ CPDE - NucleiStudio

- a X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
%][c/[=] oRun || @ 1_helloworld_debug_~ | iri+ BrA v @ T BNt ET RO T RO TR T AN S LR TR TR Quick Access|| | [
& Project Explorer = E®ly =0 2 Outline # B ar.. E[ =a
v 51 _helloworld w
2 Includes Mew > An outline is not available.
= application GoInto
Open in New Window
Show in Local Terminal »
Copy CirisC
Paste Ctrl+V
X Delete Delete
Remave from Context Ctrl+ Alt +Shift-+ Down
Source >
M
Rename... F2
= Import...
4 Export..

Build Project
Clean Project

Refresh £5

Close Project

Close Unrelated Project

Build Targets * | Sproperties S Termi TR TR
Index »

Build Configurations

41d of configuration Debug for project 1_helloworld *=**
Frofiling Tools

e ' drd/Common/Source/Stubs/close.o ./nuclei_sdk/Sol/hbird/Common/Source/Stubs/fstat.o . /nuclei_sdk/50C/hbird/Common/Source/Stubs/gettimeofday.o ./nuclei_sdk/SoC/hbi
alicate
O Run As 3
o As 5] = 1 C/Ce+ Container Application
Profile As » 2 Local C/C++ Application
Restore from Local History. Debug Configy
@ SDK Configuration Toals Ctrl+b
% Run C/C+-+ Code Analysis
Team >
Compare With >
Configure »
Source >
Properties AltEnter
<

>
1 helloworld ¥

6-12 #.1di “Debug Configuration” #47 N

8 CPDE - NucleiStudio

- o x

ile Edit Source Refactor Nevigate Search Project Run RV-Tools Window Help

S[E) = #0ebug 11 _helloworld_debug_ ~ | = I R TR AT T S gy S S S S S T S P, Guick Access i = |8
a®le =0 & Outl =7 % Docy

& Project Bxplc o o Outline iid Tar... % Docur

~ & 1_hellow

'

An outline is not available.
& Includes

& Binal

& application

& Debug

& nuclei_sdk
1_helloworld debug openocd launch

roblems & Tasks @ Console : s &Terminal = Disassemt
COT Build Console [hello world]

9 R - R

0 items selected

6-13 V)4 & Debug X
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B R FEARD, WE 6-14 fix, I H2 BRI A .
® UK 6-14 11 ShiEME, XEINGEAFERL, B17, ILEBIFIRE.
® UK 6-14 1 2 ShRIEM B, XNFARRYFEFIBITIE.

® UK 6-14 ) 3 SAREARLE, A MIXU B AT AEZAT BB WT A, BRI AT A
I BB o

® UK 6-14 [ 4 SHrvENLE, X B AT LAY g AR 2R R 1A .
® K 6-14 1 5 ShriFEME, XERRHENZEERNE.

® UK 6-14 11 6 SHRENE, XEREFETAaLUENME. KPERI2 PC A
e HT I EE

® UNE 6-14 17 ShaFENE, A B tdling LR

® K 6-14 1y 8 SHMEMEM TJr, XHEATLMEH GDB % & 5T 1.

@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE - [« ®
File Edit Source Refactor Navigate Search Pr Run RV-Tools Window Help L1] [4])

4| %/[®| vDebug  ~ Ehelloworld debug o - o wvrovavessvsafrienan TeE TE]weil iy S (5 0 o ,
Debuq & Project Explorer # 170 Gmainc @mainc  ©(gdb[11proc42000] theadGrouplillgdbl1)proc[42000] OSthread 1]} thread[1] frame(0] S Ofevi wp wERM AP 7 O] fvRegisters §eir=i =0
= helloworld debug cpenecd [GDB CpenOCD Debugging] 55 if (misa bits.b.p) { " el i|vame
2 hellowarld.elf misa_chars[index++] = 'P'; Name Type “
v & Thread #1 (Suspended : Step) o7 Yoo o int s
[ f bits.b -
= main() at main ¢85 0xB00001de =l (:i:-:;;s[l:leﬁ“l R o rval uint32 t %
£ openocd exe 70 } - ’ o miisa v_esr_t #pe
2 riscv-nuclei-elf-gdb 7 if fmlsa_tnts b.u) { 0
72 , misa_chars[indexs+] = 'U'; ﬂ,
if (misa_bits.b.v) { fiz
misa_chars[index++] = 'V'; :3
}
7 if (misa_bits.b.x) { its
78 misa_chars[index++] = "X'; ft6
it
g8 0
1 misa_chars[index++] = "\@';
82 fsl
83 printf("MISA: RVEs\r\n", misa_chars); fa0
84} fal
L 3 fa2
= ?nt main(void) fa3
58 sran d(_get rvcycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE)); fad
a nt32_t nd(); fas
S rucert wiea « RV CSR_READ(CSR_MISA); - o
1 < >
pnmtr( ”f'; exXlx\rin”, misa); bhame : misa ane P oonate
. - 93 print_misa Details:1075089769 lex:@x880807dc
rent P : F
@ Current Position ol efaulc:Le7ssssnes Decimal: -2147479588
o a5 for (dnt i = @; i < 20; i ++) { mal: 1875085789 0ctal:@20000007734
ek printf("%d: Hello World From Nuclei RISC-V Processor!\rin”, i); "ex [g)mgiqglzd Binary:18808088680B0000¢
© Break Point — 97 Yo Binary:1008008080181001¢ Default: fde <mair
; wrn @ O:ta'l axmsnmss
3 return @;
108 }
101
102 v
0 < > < 2
Memon OFs- - -

;i o5, prefi )_,ﬂ‘.[ suffix) (722)
Breakpoint 3, main (} at ../application/main.c:92

92 printf("MISA: 8xX¥lx\rin”, misa);
n

93 print_misa();

n

95 for (int 1= 0; ¢ 20; i +4) {
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6.1.4. THBITERF

TR P A ML S, v LR TR R . WiE 6-15, il FRHEY) R B Is T
W, SRR AR U)o S s AT i, B B DGRRT FERE R IRIFIZ1T . TR
BASAT AR R E S, AT ER X E. WK 6-16, FTLLE B HIEFTTEIH
helloworld %5 5. FEWIFiEE:, WK 6-17, 7E console £ H T i i 41 (o f L W T 1% 82

8 CPDE - NucleiStudio = [l X
ile Edit Source Refactor Nevigate Search Project Run RV-Tools Window Help
S. @ L. ellowortd debug o R R R AT- T P P SR P S S T ik Access] | 2 I EB
v S 1
e ebu An outline is not available.
!

nuclei_sdk
1_helloworld_debug_openocd launch

O Console » : k(M@
DT Build Console [nucleisdk]

K 6-15 T#EFEF 2T AR HiseT

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA W 75



R
NUCLEI

@ CPDE - NucleiStudio - [l X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

4//0 (=] ORun ~ [ hello_world_debug ¢ ~ 3% LA SAH RS IRNEAL H i R R S A A4t 240 Ra B R4 1]

Quick Access|: = | B8
. Project Explorer E%le =0 L =

“ B =Outline = ¥ Task ] Dou. =8
~ & hello_world -
 Binaries An outline is not available.
J Includes
application
& Debug
nuclei_sdk
hello_world_debug_openocd.launch

1% Problems < Tasks ©Console = Properties & Terminal ©
2coMn

Nuclei SDK Build Time: Aug 6 2020, 11:40:17
Download Mode: ILM

CPU Frequency 5001707 Hz

MISA: x4014912d

MISA: RV32IMACFDSPU

: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!
: Hello World From Nuclei RISC-V Processor!

=R AR SN ] #e0

CHNONbUNES

WL R R R R L e
beloahbunibe?

Connected - Encoding: Default (ISO-8859-1)

Kl 6-16 iR BY T St % 11 19 Hello World

@ CPDE - NucleiStudio - o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

40 =] ORun ~ |1 _helloworld_debug_~ (=R g BvqQvi@®von U m e WP EAvEYREYEviEvOTR AN v Fwe v -
. Project Explorer BRlw=g =0 BOutline = # Task List iid Tar.. % Docur - a
~ &1 _helloworld

Quick Access|:| & |+

# Binaries An outline is not available.
# Includes

application

& Debug

nuclei sdk

1_helloworld_debug_openocd launch

£ Problems # Tasks © Console * [ Properties #Terminal = Disassembly % Progress
1_helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe
(3276) hpmcounterllh (/32)
(3277) hpmcounterizh (/32)
(3278) hpmcounterish (/32)
(3279) hpmcounteriah (/32)
(3288) hpmcounteriSh (/32)
(3281) hpmcounter1sh (/32)
(3282) hpmcounteri7h (/32)
(3283) hpmcounterish (/32)
(3284) hpmcounter1dh (/32)
(3285) hpmcounter2eh (/32)
(3286) hpmcounter2ih (/32)
(3287) hpmcounter22h (/32)
(3288) hpmcounter23h (/32)
(3289) hpmcounter2ah (/32)
(3290) hpmcounter25h (/32)
(3291) hpmcounter26h (/32)
(3292) hpmcounter27h (/32)
(3293) hpmcounter2sh (/32)
(3294) hpmcounter29h (/32)
(3295) hpmcounter3eh (/32)
(3296) hpmcounter3ih (/32)
(3922) mvendorid (/32)
(3923) marchid (/32)
(3924) mimpid (/32)

(3925) mhartid (/32)
(a161) priv (/8)

6-17 N3 Te R o 2L (A A1 W T 4%
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6.2. M J-Link BREZETHE
6.2.1. %3 J-Link 83133\ RTT X%

HummingBird Evaluation Board 32 #{#i ] J-Link #i{. #if: SEGGER & M J-Link 5 [
(https://www.segger.com/downloads/jlink/#J-LinkSoftwareAnd DocumentationPack), R H
CURHERAE RSN 8cmofi 1) J-Link IK8h I 224% . &, J-Link FIRRALIE T v6.62 M4 .

D ARAE T B I BEATITENSm Y, AT DARS S AT IR 8N & . R A8 (6] J-Link (1) RTT 4T N
i, FZIE LT PR E

400 TAER R E TR, WK 6-18, £ “Resource” i1 A o 2T HEbR{E I bR DL 3T 91 T
FEATAER H%. WK 6-19, £ “nuclei_sdk/SoC/hbird/Common/Source/Stubs” 4% F#id—
A~ “SEGGER” U, S F kA7 RTT AH ST

& Properties for 1_helloworld O X
ty':)e filter text Resource Cyov
.:Rej“"“rce Path: /1 helloworld
Builders .
C/C++ Build Type: Project
v C/C++ General Location: D:ACPDE\T_helloworld
Code Analysis Last modified: 2020585 6H T48:.06:48
Documentation Text file encoding
File Types (® Inherited from container (GBK)
Formatter (O Other: GBK
Indexer . i
Language Mappings [ Store the encoding of derived resources separately
Paths and Symbols New text file line delimiter
Preprocessor Include Pa | (@) Inherited from container (Windows)
Profiling Categories () Other: Windows
Linux Tools Path
MCU

Project Natures
Project References
Run/Debug Settings
Task Repository

Task Tags

Validation

WikiText
< > Restore Defaults Apply
@ Apply and Close Cancel

Kl 6-18 1T LIEPT7E H %
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¥ s | Stubs - O X
bl = = =A e
«~ - 1T « SoC » hbird > Common > Source » Stubs v U Stubs’ »p

SEGGER  ~ =FR e EE ER
Syscalls | SEGGER 2020/8/17 10:18 = |
@ OneDrive ] close.c 2020/8/6 20:06 C 34
] fstat.c 2020/8/6 20:06 C 344
= R «| gettimeofday.c 2020/8/6 20:06 C 374
# 3Dz o isatty.c 2020/8/6 20:06 C 34
B asm < Iseek.c 2020/8/6 20:06 C 3zft
= EE «l read.c 2020/8/6 20:06 C 344
3 o ..i sbrl;.; i(:?r::u'ésn.w .22(?.‘: C T{‘—‘
« | stub. 020/8/6 20:06 H 34t
4 TR .
wl write.c 2020/8/6 20:06 C 3244
&%
W =m
£ .9 Windows ((
«+ Data (D)
& WA
< >
10 ~NHE =

6-19 #rit “SEGGER” ik

ZREUE T J-Link IXB MR H 3%, ¥ “Samples -> RTT” #8421
“SEGGER_RTT V68od.zip” fi# ki (HAKKLAitL4 T Re B RAA R AL ) o ff 46 5 S0

WHINE 6-20, F RTT X3 i) “SEGGER_RTT.c” ,

“SEGGER_RTT_Conf.h” =ANSCAFLL K Syscalls SCAF5 T (1)
“SEGGER_RTT_Syscalls_ GCC.c” X430 | 2| 2 BB & ) SEGGER Ak, f/atnr
6-21 flizn. £ IDE F1§]HF “SEGGER_RTT_Syscalls_ GCC.c” , WK 6-22, £ “#include

<reent.h>” FT{ERJIX—4T.

“SEGGER_RTT.h” #
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| ¥ = | SEGGER RTT_v680d - | X
*m  #z &8 )
« v 1 « Jlink > Samples > RTT > SEGGER_RTT V680d v U EE"SEGGER RTT .. 0
2020087 ~ &k : 1R IR wm Foh
nuclei_ide Examples 2020/8/17 11:14 i
SEGGER RTT 2020/8/17 11:14 prales
SEGGER Syscalls 2020/8/17 11:14 s
L : ASTRY
& OneDrive - License.txt 2020/5/25 22:54 ARSI
— README.txt 2020/5/25 22:54 AR
W R
N EDE O
B
= EA
e
¥ T
b ax
W =\
£ 4 Windows (1
Snatama Y€ 2
5 NmE
6-20 E4 NN
4 = |SEGGER - | X
« v 4 « hbird » Common » Source » Stubs » SEGGER v U = SEGGER” P
nuclei ide ~ %R ) EXE sem)
SEGGER ) SEGGER RTT.c 2020/6/28 15:41 C i
SEGGER ) SEGGER_RTTh 2020/6/28 15:41 H 324
& OneDrive «/) SEGGER RTT Confh 2020/6/28 15:41 H 3z
) SEGGER_RTT Syscalls GCC.c 2020/8/17 10:22 C X244
= e
B 3D &
Bz
= BkK
5| MY
4 T
b ER
W =m
% 9 Windows ((
« ' Data (D:)
. L 4 >
4478 j -

Kl 6-21 &l j5 SEGGER SCAFJe N2

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7

TS 79



R
NUCLEI

@ CPDE - 1_helloworld/nuclei_sdk/SoC/hbird/Common/Source/Stubs/SEGGER/SEGGER_RTT Syscalls GCC.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

S| % [ m| %Debug 1 _helioworld Debug (=B “w®v 8w - * 3 SO HvOvQUviNE

 Project Explorer E%| v © @mainc @ SEGGER RTT Syscalls GCC.c
v & 1_helloworld
 Binaries
W Includes
& application
& Debug
v & nuclei_sdk
= NMSIS
v @ SoC
~ & hbird
&= Board
v @ Common
& Include
v & Source

e RTT for printf output, incl

" Registers

ns for using printf

i Drivers
® GCC
v @ Stubs
v @ SEGGER
A SEGGER RTT Confh

# SEGGER RTTh O

: close.c
< fstat.c
¢ gettimeofday.c
2 isatty.c
: lseek.c
& read.c
& sbrkc
& stubh
< write.c
2 hbird_common.c
@ system_hbird.c
1_helloworld_debug_openocd Jaunch

e _reent struct
d by the

No consoles to display at this time.

K 6-22 FEREAE I kS F

standard 1

- [« X

Quick Access|:| & | &

&
1 9

AN TE S WS I SEGGER UK #64% % include, W1 6-23, 11487 LA ¥ E T

[f, ¥ SEGGER ¥ #4422 include .

ARSCAF TR N AR IS RS BHSOIGIT A, R SRR T IRARAL, AL, Sl A 2 it 7 i
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@ Properties for 1_helloworld O X
type filter text Settings eyov-
Resource = = - = =
~
Builders
v C/C++ Build . . N . . . . . S
Build Variables ® Tool Settings & Toolchains B Devices O Container Settings # Build Steps ' Build Artifact [ Binary Parsers @ FError Parsers
Environment 2 Target Processor Include paths (-1) a8 85l &
Logging & Optimization "${workspace loc;/${ProjName}/nuclei sdk/SoC/hbird/Board/hbird eval/Include}”
Settings & Warnings "${workspace loc;/${ProjName}/application}”
Tool Chain Editor & Debugging "${workspace_loc;/${ProjName}/nuclei_sdk/NMSIS/Core/Include}”

<

C/C++ General ® GNU RISC-V Cross Assembler

Linux Tools Path (2 Preprocessor
MCU

'$[w0rkspa(e \0(:/${Pr0jName}/nucIe'\ sdk/SoC/hbird/Common/Source/Stubs/SEGGER}"

Project Natures = Warnings
Project References & Miscellaneous

<

Run/Debug Settings ® GNU RISC-V Cross C

Task Repository = Preprocessor
Task Tags
Validation & Optimization

WikiText 2 Warnings
2 Miscellaneous

® GNU RISC-V Cross C++ Compiler > A Include & 1 B MISEGGER R k% 11
= Prep rocessz/
3

Optimization
2 Warnings
& Miscellaneous
® GNU RISC-V Cross C++ Linker
2 General
& Libraries
& Miscellaneous
® GNU RISC-V Cross Create Flash Image
& General
® GNU RISC-V Cross Create Listing
2 General
® GNU RISC-V Cross Print Size
@ General

Include system paths (-isystem) aa il

<

<

Include files (-include) L=EAR=RiR|

<

<

<

@ Apply and Close Cancel

Kl 6-23 ¥ SEGGER S 242 % Include th

BN R 5 1 write 3. InE 6-24, fE
“nuclei_sdk/SoC/hbird/Common/Source/Stubs” T “write.c” XA T, £
“Resource Configurations —> Exclude from Build” . WK 6-25, #%£# “Select All” , il
“OK” o L ARY) 4 a4 H e LT ER, w7 DU AR R 77 X B SEGGER SR I
“write.c” CAFES IR TR
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[#%][m] + Debug I1_helloworld Debug o S RN 3 WO HTOTATSE ST Sl S =
 Debug & Project Explarer New >
v & 1_helloworld a_bits.b.s) {
& Binaries Open s chars[indexs+] = 'S';
Includ Open With >
@ Includes .
. icati Show in Local Terminal 5 fa_bits.b.p) {
= application a_chars[index++] = 'P';
4 main.c Copy Cirl+C
& Debug Paste CliV  fa_bits.b.t) {
v & nuclel_sdk ® Delete Delete fa_chars[index++] = 'T';
NMSIS Remove from Context Ctri+Alt+Shift+ Down
a_bits.b.u) {
v w500 S * la_chars[index++] = 'U%;
“ & hbird Move...
& Board Rename. F2 ja_bits.b.x) {
v & Common a_chars[indexs+] = 'X';
lude ot
'S”D“’ i Export..
~ rce : .
s Refresh F5 lars[index++] = "\0';
=GCC Index > MISA: BuESi\oit misa chars);
~ &= Slubs Exclude from Build...
=SECEE b iling Tools
close.c
: fotate | Validate
qem'n, @ SDK Configuration Tools Ctri+s —Bet_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE));
» o t rval = rand();
2 isatty ¥ RunC/C4+ Code Analysis + misa = _RV_CSR_READ(CSR_MISA);
lseckc  Team >
readc  Compare With > |"MISA: @x¥lx\r\n", misa);
 sbricc Replace With 5 Hsa();
& stubh ’ i e s s
Properties AltsEnter |t i = @; 1 ¢ 20; 1 ++) {
(2 write.c printf(“%d: Hello World From Nuclei RISC-V Processor!\rin", i);

@ hbird_common.c
2 system hbird.c
1_helloworld_debug_openocd launch

< /1 helloworld/nuclei sdk/SoC/hbird/Common/Source/Stubs/write.c

6.2.2. 53 A & Debug Configuration

}

return 8;

. I
GNU MCU Eclipse Packs console
Extracting devices & boards...
Mo installed packages.
Completed in lms.

2020-28-17 11:33:18
Extracting devices & boards...
Mo installed packages.
Completed in lms.

Q@ Consale

6-24 #TJF Exclude from Build

@ Exclude from build

O X

Exclude object(s) from build in the following configurations

Debug
Release

Select All Deselect All

Cancel

6-25 % write.c Xt

B IFALE J-Link i T #1 Debug Configuration 31 F -

- o b3
Quick Access|| | R
-y 5  WiRegisters = © % =
s=|r Name Value Descripti
Name Type Value
. R d=hd
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B 7ESEHAL %S “Run—>Debug Configurations” .

B R 6-26, FEFIHIE L, WUREA AT LENFRARENS, A#5d “GDB
SEGGER J-Link Debugging” , %% “New Configuration” , ¥ NATH B #EH —
PRI H “1_helloworld Debug” , #1E 6-27. itk “Project” J& 4/ 75 2 if A M T
2, “C/C++ Application” i+ 7 IE#A T ZH A ELF 3.

@ Debug Configurations O X
Create, manage, and run configurations g\
¥ ¢ B3~

Configure launch settings from this dialog:
type filter text
[ C/C++ Application
[ C/C++ Attach to Application
&1 C/C++ Container Launcher
[ C/C++ Postmortem Debugger | = - Press the ‘Duplicate’ button to copy the selected configuration.
[ C/C++ Remote Application
Ci C/C++ Unit
[ GDB Hardware Debugging
v [ GDB OpenOCD Debugging - Edit or view an existing configuration by selecting it.

- Press the 'New Configuration' button to create a configuration of the selected type.
[# - Press the 'New Prototype’ butten to create a launch configuration prototype of the selected type.

& - Press the "Export’ button to export the selected configurations.

% - Press the 'Delete’ button to remove the selected configuration.

v - Press the 'Filter' button to configure filtering options.

1_helloworld_debug_openoc| [ - Select launch configuration(s) and then select ‘Link Prototype’ menu item to link a prototype.
New_configuration

=] GDB PyOCD Debugging

=1 GDB QEMU Debuggin [® - Select launch configuration(s) and then select 'Reset with Prototype Values' menu item to reset with prototype values.
« |= GDB SEGGER J-Link Debuggina
= 1_helloworld Debug New Configuration gs from the 'Perspectives' preference page.

& Launch Group # New Prototype

# Launch Group (Deprecated) - Export..
Duplicate
Delete

[u - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.

i Link Prototype...
Unlink Prototype
# Reset with Prototype Values

< >
Filter matched 16 of 18 items

@ Debug Close

K 6-26 i J-Link Debug Configuration
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@ Debug Configurations

FoREXER
type filter text
[ C/C++ Application
[ C/C++ Attach to Application
&1 C/C++ Container Launcher
[ C/C++ Postmortem Debugger
[ C/C++ Remote Application
€ C/C++ Unit
[ GDB Hardware Debugging
£ GDB OpenOCD Debugging
1_helloworld_debug_openoc

<

New_configuration

=] GDB PyOCD Debugging

=] GDB QEMU Debugging

=1 GDB SEGGER J-Link Debugging
[z 1_helloworld Debug

& Launch Group

# Launch Group (Deprecated)

<

< >
Filter matched 16 of 18 items

Create, manage, and run configurations

Name:hﬁe\\owor\d Debug

[ Main . % Debugger| & Startup % Source T Common % SVD Path

Project:

| 1_helloworld |

Browse...

C/C++ Application:

| Debug\1_helloworld.elf |

Build (if required) before launching
Build Configuration: Select Automatically

(O Enable auto build
(® Use workspace settings

Variables... Search Project... Browse...

() Disable auto build
Configure Workspace Settings...

Revert Apply

K 6-27 Hifx Project Al C/C++ Application 5 TFE—3%

FTF Debugger ¥ H, 41E 6-28.

Witk 1 57L& “Start the J-Link GDB server locally” #i% 9.

o B4 B IEHi¥5 7 JLinkGDBServerCL.exe [11881% .

3 TR AR, XHELLN307 A, fiA N3o7 BIF]. Wiffii A RV-STAR JF&
B X EfIA GD32VF103VBT6. 41 4 FH HAth T &t i 2% J-Link Support Device [ 71, #E4%
WF: https://www.segger.com/downloads/supported-devices.php

4 Fi%$E “Interface” N JTAG,

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A

“initial speed” N Auto.
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5 SN 5 ) GDB BB 3.

MEABEHHINE, Rl 6 SAE “Apply” /17

@ Run Configurations

Create, manage, and run configurations

CReEX[E3~

7 Build Docker Image

1C/C++ Application

1C/C++ Container Launcher

JC/C++ Remote Application

i C/C++ Unit

» Docker Compose

7GDB OpenOCD Debugging
[1_helloworld_debug_openocd
[© coremark_debug_openocd
[ cos_debug_openocd
[ demodsp_debug_openocd
[c] demotimer_debug_openocd
[c] dhrystone_debug_openocd
[c] flashhelloworld_debug_openocd
[=] free_debug_openocd
=] helloworld_debug_openocd
= New_configuration
[= plic_debug_openocd
Ertth_debug_openocd
[ whetstone_debug_openocd

7GDB PyOCD Debugging

1GDB QEMU Debugging

71 GDB SEGGER J-Link Debugging
[c]1_helloworld Debug

i Launch Group

+ Launch Group (Deprecated)
Launch over Serial

# Run Docker Image

< >
Filter matched 28 of 30 items

Name: ‘LheHnwor\d Debug

[ Main|# Debugger - & Star‘[up} % Snurcsﬂ = Cnmmnn} % SVD Path]

J-Link GDB Server Setup

(1]
|/ Start the J-Link GDB server locall (2]

["]Connect to running target

Executable path: [ ${jlink_path}/${jlink_gdbserver}

Browse... Variables...

Actual executablel] C:/Program Files (x86)/SEGGER/JLink/JLinkGDBServerCL.exe

(to change it use the global or workspace preferences pages or the project properties page)

Device name: 9 Supported device names
Endianness: (@ Little () Big
Connection: ®Uuss OIP l—‘ (USB serial or IP name/address)
Interface: (OSWD (® JTAG
Initial speed: (® Auto () Adap ) Fixed kHz! o
GDB port: 2331 |
SWO port: Verify downloads [| Initialize registers on start
Telnet port: Local host only [ ] Silent
Log file: ‘ Browse...
Other options: ‘fsw'ng\erun -strict -timeout 0 -nogui
Allocate console for the GDB server Allocate console for semihosting and SWO
GDB Client Setup [5)
Executable name: J${cross_prefix}jgdb${cross suffix} Browse...  Variables...

Actual executable:friscv-nuclei-elf-gdb

Other options:

Commands: set mem inaccessible-by-default off

Remote Target
Host name or IP address: localhost

Port number: 2331

[]Force thread list update on suspend

Restore defaults

5]

I Apply I

Revert

@ Close
6-28 ¥ & Debugger ¥ H N %
9+ “Startup” ¥ H, WK 6-29, #ifk JTAG/SWD Speed & Auto, “set Breakpoint at
main” , “Continue” , “Pre-run/Restart reset” 1 “RAM application” T2k, I HHX

VH/2)3% “Initial Reset and Halt” #ET0i.

ASCAFPITIR N AR IR B R BRI G I, RE KB B IRARAL, ALk, s A 2 APt 7
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@ Run Configurations

Create, manage, and run configurations

CEeRX B2~

type filter text

<

<

£ Build Docker Image

[E1C/C++ Application

€1 C/C++ Container Launcher

[E1C/C++ Remote Application

€ C/C++ Unit

© Docker Compose

[£1GDB OpenOCD Debugging
£ 1_helloworld_debug_openocd
[ 2_helloworld_debug_openocd

[E1GDB PyOCD Debugging

=1 GDB QEMU Debugging

[ GDB SEGGER J-Link Debugging
=1 1_helloworld Debug

& Launch Group

Name: ‘1_he|\ow0r\d Debug

£ Main % Debugger | & Startup - % Source| Common| % SVD Path
Initialization Commands

[ 1Initial Reset and Halt Type: Low speed: 1000 kHz
JTAG/SWD Speed: ® Auto () Adaptive () Fixed kHz
Enable flash breakpoints

Enable semihosting Console routed to: ] Telnet /] GDB client

Enable SWO CPU freq: |0 Hz. SWO freq: 0 Hz. Port mask: Ox1

Load Symbols and Executable
Load symbols
(® Use project binary: 1_helloworld.elf

& Launch Group (Deprecated) (O Use file: Workspace... = File System...
) Launch over Serial Symbols offset (hex): |:|
4 Run Docker Image Load executable
(® Use project binary: 1_helloworld.elf
(O Use file: Workspace... = File System...
Executable offset (hex): |:|
Runtime Options
I] RAM application (reload after each reset/restart) |
Run/Restart Commands
Pre-run/Restart reset Type: | \ (always executed at Resta rt)l
["]Set program counter at (hex):
Set breakpoint at: main
Continue
Restore defaults
Filter matched 17 of 20 items Reverr Apply
@ Run Close

K 6-29 % Startup F2H A%

LA bR E N 5E
Py

6.2.3. £ R B R iR L AR

BOG, WRAREFE S EA A Apply RGP IRE, R EA LS S close

ff ] J-Link £ HummingBird Evaluation Board i 7 ZiEER 2. WK 6-30, ZLHEFRVER)
Hr#& J-Link 7 B IERERINR T HIE . Horb VTref 3T F V3.3 M0, HAh# 0 ZE#ES
JTAG #2110, %5 L ENsRIES310, — XN IERRIT, &/aScWnERanE 6-31.
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VTref 1(e] e2 [NC
nTRST 3@ [®4 |GND
TDI 5 ® 6 |GND
™S 7E| ® 8 |GND
TCK 9 ® 10| GND
RTCK I:u ® @ 12|GND
TDO 13[0] e 14|=x
RESET 15 @ ®16|*
DBGRQ 17 @ ®18|x
5V-Supply (19 ® ® 20| *

6-30J-Link FI#IE

.

‘- ~ o .
J-Link VTref Pin Connection > a3 I :
, : -

- & p—
.

10—Pin§ Horn Socket

WY ‘
\ )
\\\

P(;‘!'er Line
6-31J-Link s

\

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7 Wi 87
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FEFT R BRI /T, WRAET B CTED, w5 #5%H: JTAG L& D5 R 3 SRy N L,
PHTIT 8 DAL S Printf ek 84T EE R . anRAH RTT 4TH), #F2E4TJT J-Link RTT Viewer #
F printf ITEMS B . WA 6-32, MR NAIKE, 18 USB 7% #:. Specify Target Device
IR RN ZREE, X B L N3o7 Nfl. Target Interface & Speed ¥ & & 1000kHz, A
PaszBrfif & L RE L. RTT Control Block #£#¥ Auto Detection.

J-Link RTT Viewer V6.80d | Configura... ? X

gnnection to J-Link

[ ] Serial No

() TCP/IP
() Existing Session

Specify Target Device
N307 v

Script file (optional)

Target Interface & Speed
JTAG ~ 1000 kHz -

h ontrol Block
() Address () Search Range

J-Link automatically detects the RTT control block.

0K Cancel

6-32 % & RTT Viewer

K 6-33 1 M uMEL T Debug, 5 ZEMEbR AN H BIEbR, SBT3 AR R
BREFHENTF RARH

QRN KT, WAnE 6-34 s, H 8 sl g .
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B U 6-34 11 ShMEME, XBINGEESERL, 81T, ILmMBIREE.
B 6-34 1) 2 ShRENE, XNEKER YR IBITAE

B K 6-34 1 3 SARENE, ARSI M0 R AT A2 AT B B R, FRJOW AT UG
W7

U 6-34 11 4 SAREALE, X AT LY g R A
B E 6-34 11 5 ShrEME, XELRBNLERRIAME.
B A 6-34 116 SHrEME, XEEEEFAAREENME.
B WK 6-34 1 7 SEMEME, T B O R DGR H g

B K 6-34 1 8 SHMEALE T, XEATLMER GDB 5 545 23T .

@ CPDE - 1_helloworld/application/main.c - NucleiStudio o X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
& [E) =] #Debug @ 1_helloworld Debug SR Bvava@®ven VR ALY E Y YO A A INE o v e v oo~ Quick Access| | @ | &
Project Explc o @mainc = Outline
O Run c(; bt b.s) { X AR e w|

rs(index++] = u stdioh

gf bits.b. u timeh

(uisa_bits.b.p) { u stdlibh

misa_chars(index++

"
A

} 22 nuclei_sdk_soch
if (misa_bits.b.t) { « print misa(void)
misa_chars[index++] = 'T'; « main(void) :int

}
if (misa_bits.b.u) {
misa_chars[index++

<

1_helloworld_debug_openocd launch }
if (misa_bits.b.x) {
misa_chars[index++

}

misa_chars[index++] = "\@';

printf("MISA: RVEs\r\n", misa_chars);

83-int main(void)
sa {

and(__get_rv. ey le() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
nt32_t rval =
rv_csr_t misa = nv CSR_READ(CSR_MISA) ;

printf("MISA: @xXlx\r\n", misa); V.

© Console ol = R

COT Build Console [1_helloworid]
19:15:38 **** Incremental Build of configuration Debug for project 1_helloworld ****
make all
Invoking: GNU RISC-V Cross Print Size
riscv-nuclei-elf-size --format=berkeley "1_helloworld.elf"

text  data bss dec hex filename

8394 112 3448 11954  2eb2 1_helloworld.elf
Finished building: 1_helloworld.siz

19:15:38 Build Finished. @ errors, @ warnings. (took 325ms)

Writable Smart Insert  95:1

K 6-33 Ul T
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@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help o
&[% [®] Debug  ~ Ehelloworld debug op | [ ¥ wvrovavessvsafrienan TeE TE]weil iy vl
#Debug & Project Explorer > “maine @ @maine T (gdbl11proc42000] threadGroupli1Lgdb{1]proc[42000] OSthread(1]) thread(1] framel0]

~ [ helloworld_debug openocd [GDE OpenOCD Debugging]
~ & helloworld.elf
« # Thread #1 (Suspended : Step)
= main{) at main.c95 0x80000fdc
£ openocd exe
2 riscv-nuclei-elf-gdb

@ Current Position N

2
© Break Point—""

28
99
100 }
101
182

B Console

if (misa_bits.b.p) {
misa_chars[index++] = 'P';

}
if (misa_bits.b.t) {
misa_chars[indexs+] = 'T';

}
if (misa_bits.b.u) {
misa_chars[index++] = 'U';

}
if (misa_bits.b.v) {
misa_chars[index++] = 'V';

}

if (misa_bits.b.x) {
misa_chars[index++] = 'X';

}

misa_chars[indexs+] = "\@';

printf("MISA: AVEs\rin", misa_chars);

main(void)

srand(_get_rv_cycle() | _get_rv_instret()
uint32 % rval - rand();
ru_csr_t misa = _RV_CSR_READ(CSR_MISA);

__RV_CSR_READ(CSR_MCYCLE))

printf("MISA: @x¥1x\rin", misa);
print_misa();

for (int i = @; i < 20; i ++) {
printf("%d: Hello World From fiuclei RISC-V Processorlirin”, 1);
}

return @;

)

2 [ Problems © Executabled @ Debugger Consle = ) Memory
helloworld_debug_openocd [GDB Ope T STeross, prefidgdbscross suffix) (222)
€:92

Breakpoint 3, main () at ../applicat

az

6.2.4. TREBITERF

printf("MISA: Bx¥lx\r\n", misa);
print_misa();

for (int i = 8; i < 20; i ++) {

K 6-34 TaESEMUA #E AT

Y1 %B HERM %P ™ 7D

Name Type

<

o int
o rval uint32_t
o misa s t

Name : misa

Details: 1875889782
Default:1e75e897e9
Decimal: 1875883789
Hex:@x4014912d
Binary:1000000000101001¢
Octal: 018885118455

“Registers 4
Mame ~
t4
5
16
e
o
it
itz
3
it
its
6
it
fs0
sl
fa0
fal
fa2
fa3
fad
fas
faf

lame : pc
Hex:@x80000fdc
Decimal:-2147479588
Octal: 820808887734
Binary: 1222080000000000¢
Default:@xseeeefdc <mair

>
@Ee- -

VRRE PP B B ABUR AT DCREAEFS N 8EETF R . I 6-35, iy FRAEDIHe = isqTii

2o BRI 00 B AR 2 D) 2k

BATIGEE, PRI R N EE IR ROTIEAT .

1 R

AT FE R B, PTG ZERIRRE. WK 6-36, Al LIE S| RTT Viewer 1EFHTT EIH!

helloworld 2515 5. W7 E W &R, WK 6-37, 7E console £ H

%,

N R AL AR R AT T %

ARSCAF TR N 2R BRSO SRR K I A, RE

2SRRI, AL, S A 2 APt 7
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@ CPDE - 1_hellowa

F

Project Ex
roject Exple=

v &1

fit Source Refac

ication/main.c - NucleiStudio

ate Search Project Run RV-Tools Window Help

®| ORun 1_helloworld Debug -

main.c

- if (misa_bits.

misa_chars

hello

Binarie # Debug =
Includes if (misa_bits.b.p) {
application misa_chars{index++] = 'P';
mainc
Debug
nuclel_sdk =T
NMSIS - 2 .
e if (misa_bits.b.u) {
2 misa_chars[index++] = 'U";
1_helloworld_debug_openocd launch 3

if (misa_|

misa_chars[index++] = '\0';

printf(“MISA: RVEs\r\n“, misa_chars);

int main(void)

srand(_get_rv_cycle() | _get_rv_instret() | _RV_CSR_READ(CSR_MCYCLE
ui rval = rand();
SR_READ(CSR_MISA);

printf(

@ Console

CDT Build Console [1_heliow

eley "1_helloworld.elf"
hex filename
11953 2eb2 1_helloworld.elf

Finished building: 1_helloworld.siz

38 Build Finished. @ errors, © warnings. (took 325ms)

s

Writable Smart Insert

6-35 NEFLF RIT R IEAT

J-Link RTT Viewer V6.80d

File Terminals Input Logging Help

Terminal O

Nuclei SDK Build Time: Aug
Download Mode: ILM

CPU Frequency 5060724 Hz
MISA: ©x4014912d
MISA: RV32IMACFDSPU
: Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From
: Hello World From

Terminals

Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei
Nuclei

PFROUONOUDWNRE®

17 202e, 18:52:11

RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V
RISC-V

Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!
Processor!

Clear

Temp.
HW instruct
Support set

halted CPU for
ion/data B

HW data BPs trigger befor

RTT Viewer connected.

ATT Viewsr connected.

hile running:

ution of inst

0. 004 NB

6-36 fIEN% it Hello World

Outline

stdioh
timeh

stdiibh

nuclei sdk soch
print_misa(void) : void
= main(void)

78:32

A

Jiri

BB FIBCN SRR Z AT, RESAKR LB, AHERE. EHIS R A 2 BT 4 4 -
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@ CPDE - 1_helloworld/application/main.c - NucleiStudio ul X
File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help
4 0 = ORun )1 _helioworld Debug (=R s BvqavLi @O - LR AvEvLvE Y HYOTR QA YNE S~ 4 v jliwe

Project Explorer 4 main.c = ©10x200001ca Outline
~ &1 _helloworld 62 if (misa_| lnts b.s) { ~ W R *
> 63 misa rs(index++) = 'S"; stdioh
i(( SR u timeh
misa_bits.b.p
misa_chars[index++] = 'P'; u stdiibh
} nuclei_sdk soch
if (misa_bits.b.t) { = print_misa(void) : void
misa_chars[index++] = 'T';  main(void)
if (misa_bits.b.u) {
72 misa_chars(index++] = 'U';
1_helloworld_debug_openocd launch 73 }
2 if (misa_bits.b.x) {
misa_chars(index++] = ‘X
}
misa_chars[index++] = "\e';|
printf("MISA: RVEs\r\n", misa_chars);
§3-int main(void)
srand(__get_rv. ey le() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
uint32 ¢ rval =
rv_csr_t misa = _nv_csn_wsw(:sn MISA);
printf("MISA: 8x¥lx\r\n", misa); v
S Console D HFMevoy
1_helloworld Debug [GDB SEGGER J-Link Debugging] JLinkGDBServerCLe
Down 1oad: ng 460 bytes @ address 8x20000000 - Verified OK ~
Downloading 7486 bytes @ address @x20000200 - Verified OK
Downloading 528 bytes @ address 8x20001EF@ - Verified OK
Downloading 112 bytes @ address 6x20002100 - Verified OK
Comparing flash [........cceveernrnns ] Done.
Writing register (pc = @x200@0@cc)
Received monitor command: regs
X0 = 00000000, X1 = 00000000, X2 = 00000000, X3 = 00000000
X4 = 00000000, X5 = 00000000, X6 = 00000000, X7 = 00200000
X8 = 00000000, X9 = 00G0G000, X10= GAAE0000, X11= 08060000
X12= 00000000, X13= 06060000, X14= 000ROEG0, X15= 80000000
X16= 00000000, X17= 00000000, X18= 00000000, X19= 00000000
X20= 00000000, X21= 00000000, X22= 00000000, X23= 00000000
X24= 80000000, X25= 0B0GE0O0, X26= B0GERE00, X27= 000EEOED
X28= 00000000, X29= DOOGOG0O, X30= 0P0E0RE0, X31= 80800000
PC = 200000CC
Reading all registers
Starting target CPU...
< >
Writable Smart Insert 78132

Bl 6-37 N ER5E ARy 41 R L T

7. 2 IBRRA Nuclei Studio A& TiE

Nuclei Studio M 2020.08 A 46, B J5 T.E%EM GNU MCU RISC-V GCC (riscv-none-
embed-gee) Ft 2% 3] RISC-V Nuclei GCC (risev-nuclei-elf-gee), K A% A58k 42481k, FrbAf#E H
201909 K H 7 FIRA ) IDE A i) LFE, Zeit 5% & 5 4 v LAAE BT iRAS IDE Fff A . X DL
201909 it A Nuclei Studio 4= 5 f¥] helloworld TFEAH, SN RSB E RVEAL BT -

B 3 201909 ALK helloworld THE, TE4HRTRATT RiEZH 4.2 71, X BAfMEE

B FATEEATILESE “Properties” T E T, 1&# “C/C++ Build > Settings” ,
FTJF Toolchains ¥4 H 2R 51524 Name FHiikZi A “RISC-V Nuclei GCC (riscv-nuclei-elf-
gee)” , WATR. 1BMJE M Apply PRAFIE

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA W 92
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@ Properties for hello world O X
Settings T
Resource
Builders
C/Crr Build Configuration: Debug [ Active ] ~ | Manage Configurations...
Build Variabl
Environment . . . . q = 5 a q
Loaging % Tool Settings ® Toolchains W Devices O Container Settings # Build Steps " Build Artifact @ Binary Parsers © Error Parsers
Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc) VI
Tool Chain Ec Architecture: RISC-V v
C/C++ General
Linux Tools Path | Prefix:
M suftc [ ]
Project Referenc i
Run/Debug Sett C++ compiler:
Task Repository Archiver: ar
Task Tags Hex/Bin converter: |objcopy
Validation - -
WikiText Listing generator:  |objdump

Size command: size

Build command:

3
2
=~
o

Remove command: rm

Toolchain path: ‘$€e(\Tpse_hume)\\toolchain\\gcc\\bin |

(to change it use the global or workspace preferences pages or the project properties page)

Build tools path: ‘$€ec\Tpseihome)\toolcham\bui\dftools\an |

(to change it use the global or workspace preferences pages or the project properties page)
[“] Create flash image

Create extended listing
Print size

< > Restore Defaults Apply
@ Apply and Close Cancel

B 7-1 %% Nuclei Studio T H4%

B BXURA T LIRS “Clean Project” P “Build Project” B[,

8. I I i
8.1. Nuclei Studio J53h1g

Nuclei Studio /&£ T eclipse #ATH &, 4674 T eclipse A4~ MRS 552 [FIN, A7 7E
ERSVEEIINE, H-Rashiy, BT EIEIRE; AR SR s A8 Workspace.
£ 2021.09 i) Nuclei Studio ', FATEFXE s 704k, 7ERNTERE B HIRTIR T, 2B —%A
5] Nuclei Studio BE7E— 7781 N 58 ik

Nuclei Studio & iz {7 1%

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA WG 93
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B  Windows 10 ¥:/E &%t

B 4G LLENA (2G 7] LAY Nuclei Studio 73 Bef# 1D

8.2. Nuclei Studio % FfREFR1E

FEM A AR, AT I Nuclei Studio 782w %501 H i 2 R BURE LG, L HE%
B, ZHA R 360 REHAENT, JiFTELPUTIRE, 1B 360 RERHAFN, iR n LUZIE

HOEERAT . N T IRFE Nuclei Studio FIIEW ], EIAEM I IR 1 360 5% #H .

8.3. #TJF /3% Launch Bar

TSP “Window -> Preferences” , ##& “bar” , WE 8-1, HWyHZES — IR AT

%M Launch Bar. [#, $HZ#H Launch Bar I, %2k %k,

= Preferences

m Launch Bar

RurE/Deb:_g Preferences for the Launch Bar
w Launching
[ E Enable the Launch Bar |l

O &k bart | @ UL WL

< >

=3 "
@ s @®

Enable the Build button
[] Always show\the target selector

Restore Defaults

Apply and Close

Apply

Cancel

K 8-1 %/ Launch Bar

8.4. f§ M Launch Bar

Smartchip Studio [) Launch Bar (B F & AHE R bRyE ) X 120 FE A%k A 193 1k

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A
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e B R B AR TR 3. AR FE A, Wi b iE =, Bbs 5 FRHEH R
BeE N AMIE . N 4H Launch Bar %35 D) fg:

O; 5,

&5 Project Explorer @ Run S ¥ =8

@O ®| | ORun [c] helloworld_debug_openoc G G

»i=helloworld 1% Debug

K 8-2Launch Bar ZjfE/4H

PIbm 1 g iRade v AR B 6 N DR . e ARk i TR 5 5 N RIAEE A i R B
N T.F2, FF4F Project Explorer H1 ik H f) T 2

Elbr 2: 3247 /0% P I R B X B 1 T RE o HEAL AR 2R IE S HIAE 4 1IN FAR1L
Klbr 3: 1R T 2/ AR .
NRIHE 4. UMk N/ AR U1 s 2 SR ERR 2 FERAE
TNHAE 5: e iEEECE . AR N BRI EIRR 1. 20 3 R TR
WA EIAR 6: T4 AnE AR E U, W E BT B R -
8.5. Af#EF Launch Bar #47E47 /R

ST HVCHTEE R TR, WA E A Launch Bar ThAg, afLLA#E TR, % “Debug As ->
Debug Configurations” . 7E5LE Hik £ TR0 M A% Bk D, 1XELL helloworld T4, 41
8-3, % “helloworld_debug_openocd” , ZJGik# “Debug” F4fiHiK.

[FH, Vst FEA o TR, #%4#% “Run As -> Run Configurations” . 7E# & ik £ %
XML B IED, 2 JEiESE “Run” FFIRIEAT .

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA g 95
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€ Debug Configurations J X
Create, manage, and run configurations ﬁ\
[ BeEXBY - Name:|hel\oworld_debug_openocd ‘
‘type filter text ‘ E Main - # Debugger # Startup|% Source ™ Common 7. SVD Path
~ [E C/C++ Application Proiect:
helloworld.elf s
[ C/C++ Attach to Application |hE”0W0”d Browse..
[E] C/C++ Container Launcher C/C++ Application:
[ C/C++ Postmortem Debugger |Debug/he\|0w0r\d.e\f
[ C/C++ Remote Application : -
€ C/C++ Unit Variables.. | Search Project... Browse...
€ Debug Adapter Launcher Build (if required) before launching
@ DSF PDA Application Build Configuration: Select Automatically v
[ GDB Hardware Debugging
& GDB Jumper Debugging (O Enable auto build (O Disable auto build
+ [ GDB OpenOCD Debudain (® Use workspace settings Configure Workspace Settings...
I helloworld_debug_openocdl 0
GDB PyOCD Debugging
= GDB QEMU Debugging
[ GDB SEGGER J-Link Debugging
A Launch Group
Filter matched 17 of 17 items Re‘é“ Apply
® Close

8-3 MM Launch Bar 1 #4713
72 TR T DL 7 R AT R AT, AR i T T R R, e
PN B TR T IR . T84T, WRME © 7 B FROET, Uik Bt R E
8.6. Debug WHEFE 75

kN Debug #ixU)5, FREH LLTIHIFFARES —I (MR A, X EUUEE T E . 5%
BREERE “Window -> Show View -> Registers” T Z/7ast= H . [FIFE, WRAEAFNAE, vL
iEF “Window -> Show View -> Memory” , 8FTHiAiEHl &, ILLEHRE “Window -> Show
View -> Debugger Console” , HAh UL LA OS24, & H P BATIREK .

8.7. Debug WIE % K&

7t Debug T ZIR R, 7 i ® B K. BRI 2 AR S 8RS, 7E Debug
i, A5t Debug £ H i dtfE, #%EFF “Terminate / Disconnect All” 5% frf Debug i .

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 96
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8.8. Nuclei Studio T B &5 ThRe
1E Nuclei Studio #, # WA LEEENINT, AR RN B2 D6
i By R vER ErE Yy YyE Yy H YO vRYQy @O vy JRE 7D 0| S %G HY §l v R v |

AN E e (e
S = . ®
AT ™ AR RS =

-

bk _. NN
YRR E © T, AU Debug Al Release, FiJAT TR, X EAMA.

TR T L AT F RS Project Explorer i 9 T L.
HHEFTE TR ™, — Utk #FTA Project Explorer i) T72.

g™ T F YT O s rmee, BROE, ARG,
it T AR TR R R E R AR TR

w7 Q7 W T R TR R R B AR R TR

Profile 7, {1 Profile Tk, TR, HAFHALA,

L \
M B E XA o BEAEAMEA Y H, R AT E CIRABE T

ASCAFTER A A AR SR BRI, REGRBCIETIRE, A, e A2 2R A g 97
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== g e
% T A L RIS, A%,
d = E 7 R
YAMETE o, AR A A I,

G TR D AT S R b G o 112

[::-

8
Debug | s ATE BRI A W, 53 SEP Restart Zhfg.

%% CMSIS F, eclipse EIETRE, AL

Nuclei SDK Iﬁﬁﬁiﬁ@ , Z 5.1,

- v IO oow v|=ﬂ'

SO P 3 A T, ATRE PR, AR E L

EZIN R

8.9. ExHAERD

% IDE {0 L © BT LEISORIR 0 R, K HIOE C/Cat SRR Debug BT, 3¢
H, fEit N Debug UK, #ANE Debug T, SFMESRN, B SS “Switch” 1EDAT L
P)#: 2 Debug T H. 732 A HIEE “Window -> Perspective -> Open Perspective” T DAL
PIEST YN N

EAFMELDT, “Window -> Show View” BRI AL AHF. WK 8-4, fE Debug
o O] DU R R R INZF 748 (Registers) , W47 (Memory) FflifiR#zH] 4 (Debugger

Console) .
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Window Help
" New Window
Editor

Appearance

Show View

Perspective
Navigation

Preferences

v ovv v v

N |

° Breakpoints

& Console

+ Debug

@ Debugger Console
# Debug Sources
= Disassembly

%) Error Log

O Executables

@ Expressions

0 Memory

0 Memory Browser
= Modules

&= Outline
Peripherals
Problems
Progress
Project Explorer
il Registers

5 Signals

& Templates

& Terminal

% Trace Control
= Variables

2 Visualizer

Other...

EF g Ew

EARAE ok ]

Alt+Shift+Q, B

Alt+Shift+Q, C

Alt+Shift+Q, L

Alt+Shift+Q, O

Alt+Shift+Q, X

Alt+Shift+Q, V

Alt+Shift+Q, Q

8-4Debug HAAF IAEE 1

8.10. IEBINE O A/

SRR “Window -> Perspective -> Reset Perspective” , 7E# & rhik#% “Reset

Perspective” AJ LK & 1 ERINAT R o

8.11. Xt bt jg e3¢

A EEE RS, %% “Compare With -> Local History” 17 52id5%. WK

8-5, EFTJTH] History #% H Wil F2ExS LB SO P sefleAs, wT DL SO A2 s g s .
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[¢ mainc  &°Compare main.c Current and Local Revision & = =
[ C Compare
v [@ Translation Unit
° print_misa
9 C Compare Viewer £ MBE4ndR
Local: main.c Local history: main.c 2020561283300 T42:33:30
4#include <stdlib.h> 4#include <stdlib.h> ~
S#include "nuclei_sdk_soc.h” S#include "nuclei_sdk_soc.h”
6 6
7void print_misa(void) 7void print_misa(void)
8{ 8{
9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_READ( 9 CSR_MISA_Type misa_bits = (CSR_MISA_Type) _ RV_CSR_R
1e static char misa_chars[30]; 10 static char misa_chars[30];
11 uint8_t index = ©; 11 uint8_t index = ©;
12 if (misa_bits.b.mxl == 1) { 12 if (misa_bits.b.mxl == 1) {
13 misa_chars[index++] = '3"; 13 misa_chars[index++] = '3";
14 misa_chars[index++] = '2'; 14 misa_chars[index++] = '2";
15 } else if (misa_bits.b.mxl == 2) { 15 } else if (misa_bits.b.mxl == 2) {
16 misa_chars[index++] = 16 misa_chars[index++] = '6";
17 misa_chars[index++] = 17 misa_chars[index++] = '4";
18 } else if (misa_bits.b.mxl 18 } else if (misa_bits.b.mxl == 3) {
19 misa_chars[index++] = 19 misa_chars[index++] = 'L";
20 misa_chars[index++] = 20 misa_chars[index++] = '2";
21 misa_chars[index++] = 21 misa_chars[index++] = '8";
22 )3 3
[ 23] b7 23 if (misa_bits.b.i) {
24 if (misa_bits.b.i) { 24 misa_chars[index++] = 'I";
25 misa_chars[index++] = 'I"; 25 ¥
26 } 26 if (misa_bits.b.m) {
27 if (misa bits.b.m) { 27 misa charsfindex++1 = 'M": 4
< > < >

¥ Problems ¥ITasks & Console = Properties & History #
main.c
Revision Time

= 2020/12/31 £510:22

= 2020/12/31 £E49:30

= 2020/12/31 £549:29

= 2020/12/30 F42:33

8-5 Xf Hb g s s 4

8.12. HTE TAER FI R tH DIk 48

W LA IDE FR 2R g1 A TR, ARYE EHLIERE I I AN R BN RER =,
RESE FIR 5|7 error, K545 error 2K IHILILLEILE, 1 DA B2 SR EE N
k.

8.13. # ¥ Include B2 HMEL

7t include TAGHTIEERAEIT, AlRE< HILSZAFIIBEI2 N ES, LR i Workspace BY File

8.14. BE NI B R AZ

AT ATRERDY B RN, o B EA HARGEESK, WA 8-6, A i ZLAE P A2 4 U A b
BoRFEAEH
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]
type filter text Settings vor
Resource
~
Builders X . . - -
v C/C++ Build Configuration: |Debug [ Active ] ~  Manage Configurations...
Build Variabl
f;;'g_’r:gmmt ® Tool Settings # Toolchains B Devices 0 Container Settings # Build Steps " Build Artila(tE
i
Settings Name: RISC-V Nuclei GCC (riscv-nuclei-elf-gcc)
Tool Chain Ec | arcpitecture: RISC-V v
w C/C++ General
Prefix: riscv-nuclei-elf-
C/C++ Langu e gl A o g (A
: ) stz 7] Beb il ) £
Code Analysi Suffix: ! 'lt&t J\l = ’hiﬁfjjf r I
Documentati C compiler: acc
File Types c iler
Formatter ++ compiler g++
Indexer Archiver: ar

Language M: Hex/Bin converter: |objcopy
Paths and Syi
Preprocessor
Profiling Cate Size command: size

Listing generator: | objdump

Linux Tools Path Build command:  make
MCU
Project Natures

Project Referenc
Run/Debug Set! Toolchain path: ${eclipse_home}\toolchain\gcc\bin

Remove command: | rm

Task Repository (to change it use the global or workspace preferences pages or the project prope
Task Tags Build tools path: | ${eclipse_home}\toolchain\build-tools\bin
Validation (to change it use the global or warkspace preferences pages or the project prope
WikiText
[v] Create flash image
[] Create extended listing
[v] Print size
< > v

@ Cancel
8-6 WorFaiEl: H
8.15. FRIX FEEEIRIE

UARIB BT AR N B LR, HEAR M BUEN R, B UIHEEH] USB3.0 %1, WR{E
BN A&, iR RN USB # LR E N 3.0.

8.16. Linux 33 T % A P/ Nuclei Studio

R E 2 2 F I Nuclei Studio CRHfER) , /2 #E324T Nuclei Studio It 5 25 Z4T
FE A “Window->Preferences” . £ o 75 M =MLy :

® F]JF “MCU->Global OpenOCD Path” , “Executable” #i A\ “openocd” , “Folder”
N “${eclipse_home}/toolchain/openocd/bin” .

® ITJF “MCU->Global QEMU Path” , “Executable” #i A “qgemu-system-riscv32” ,
“Folder” #i N\ “${eclipse_home}/tools/qemu”

® JTJF “MCU->Global RISC-V Toolchains Paths” , “Default toolchain” i “RISC-V
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Nuclei GCC” , “Toolchain folder” #i A\ “${eclipse_home}/toolchain/gce/bin” .
Bk a fidr “Apply and Close” {54735 ¥ B 35 .

8.17. & EHBFIRFHEAEO

A REER A R EAR S E B h UM AN R 0, g 8-7, b COM 2 5 UK 2 5 14T
ENEAT, W RABE A & R 55 TREREEITEER, HEEEAZ LM COM 45 H/MIH
Ho

v § %0 (COMFLPT)
f§ USB Serial Port (COM36)
i USB Serial Port (COM37)
3 EfF
> B N
> O mEs
> e
0 BF
W ARFBAIRE
> B RiFgE
> BF B
9 EVRBLRE
i BAE. R e
> @ BIFEIEEHRE
v § EESRTRLRHES
¢ Intel(R) USB 3.1 BT¥ @E#H 132488 - 1.10 (Microsoft)
USB Composite Device
USB Composite Device
USB Serial Converter A
USB Serial Converter B
USB tRE&E428(USB 3.0)
& SuperSpeed USB $E£538
B USB $E£:38

8-7 W HLE T B R

9. Nuclei Studio 2%

— s, @R Nuclei Studio %A KHIMAASZ), Nuclei Studio F+2¢ TAERI LA AR

AT A A AR SRBHIR AT, REGKRBBEIEA IR, Ak, e A 2 2 sin 7 WA W 102
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I GNU T H 55 DL H At AR 3¢ T A1 F+ 2% IDE Plugins 177 2k 5
9.1. GCC/OpenOCD % T B4k 2

Nuclei Studio CL &4 T B A S i AE IDE N6, T HAEFAE NucleiStudioIDE_ XXX 3
Jey, &4 N: NucleiStudio_ IDE_XXX\NucleiStudio\toolchain. IDE ZR\{# HIER42 ) T B
B, PTUAEAZEFRES) “toolchain” BSCHEJE, (] IDE i T2 )5 AR B AT T R EEMAH CHD
H.

T TR HIEE S IDE tR, Frol)a &2 M~ Fah g RgE, TREETH0ED

B e MMBR TR EE Y GCC 8% OpenOCD SCAFW N ZE, SRIGTECSREHS B W T 8 Hr
A GCC 5¢# OpenOCD.

B 4 GCC 53 OpenOCD 1) 4 75 & il BN B 1) SO, B AT 5¢ i IDE T EL 8% (1 5558,
IDE [ i T B KR A S0 7E ReadMeutxt 1, WK 9-1 fion. VEE: BARIE gee i
TEMIX — 2% B S U FAAE, B4 5 fRiE bin SCHEIEFTTE 2 902 B oo 3211 B
3, RN EA HAR AR

build-tools 2020/7/30 10:35 prgl=>c

gcc 2020/7/30 10:35 AL

openocd 2020/7/30 10:35 A3
=| ReadMe.txt 2019/9/25 13:48 NASRY

K 9-1IDE T HE ikt
9.2. IDE Plugins #%
Nuclei Studio > #f IDE WEL T2, SRUIT.
B W 9-2, FIHFRAREMFE, EREAZIES “Help > Install New Software” .

B UiE 9-3, fiili “already installed” #7HF B 2234 FL T .
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B 0K 9-4, EFF “Nuclei Studio” ,

€ CPDE - 1_helloworld/application/main.c - NucleiStudio
File Edit Source Refactor Navigate Search Project Run RV-Tools Windaw|

&|[%|[m| #Debug  ~ 1 helloworld_debug_~

 Debug - Project Explorer
v & 1_helloworld
 Binaries
 Includes
« & application
4 main
& Debug
& nuclei sdk
1_helloworld_debug_openocd launch

/1 helloworld/application/main.c

N B R Y P PR T S
2 main @ Help Contents

e 4 Search

63 Show Contextual Help

vt Show Active Keybindings... Ctri+Shift+L
p ~ Tips and Tricks.

€7 & Report Bug or Enhancement...

68 Cheat Sheets.

6

s ® Eclipse User Storage >
71 % Perform Setup Tasks..

72 Check for Updates

’; < Install New Softwal

e Eclipse Marketplace.

76 @ About NuckeiStudio

77 Contribute

78 MIsA_chars[Ingex+] = 8"}

88 printf("MISA: RVEs\r\n®, misa_chars);
51}
_51

53-int main(void)

84

g5 srand(__get_rv_cycle() | __get_rv_instret() | __RV_CSR_READ({CSR_MCYCLE));
86 uint32_t rval = rand();

57 rv_csr_t misa = __RV_CSR_READ(CSR_MISA);

printf("MISA: @x¥lx\r\n", misa);
print_misa();

for (int i =@; 1 < 28; i +4) {
printf("%d: Hello World From Nuclei RISC-V Pracessor!\r\n”, i);

return @;

O Console T xeculables @ s
<terminated> 1 helloworld_debug_openocd [GDB OpenOCD Debugging] openocd.exe
(3295) hpmcounter3eh (/32)

(3296) hpmcounter3ih (/32)

(3922) mvendorid (/32)

(3923) marchid (/32)

(3924) mimpid (/32)

(3925) mhartid (/32)

(4161) priv (/8)

9-2 FITT LA AT Hh

“-Variables &

Name

Ry “update” BIA] H 3l 5¢ BAELR BT

Type

- X%

Value

FL-El=hd

[

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7
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@ Install | X
Available Software _)
) -
Select a site or enter the location of a site.
3 a N
Work with: |l e K ~ Add... Manage...
type filter text Select All
Name Version Deselect All
[ ]@ There is no site selected.
Details
Show only the latest versions of available software Hide items that are already installed
Group items by category What isfalready installed?
[]Show only software applicable to target environment
Contact all update sites during install to find required software
@ < Back Next > Finish Cancel

K 9-3 1T e il
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@ NucleiStudio Installation Details

type filter text

Name

i GCov Integration

- GDB Tracepoint Analysis

(@ Git integration for Eclipse

@ GNU MCU C/C++ ARM Cross Compiler

G GNU MCU C/C++ CodeRed Debug Perspective

[ GNU MCU C/C++ Generic Cortex-M Project Template

@ GNU MCU C/C++ J-Link Debugging

G GNU MCU C/C++ OpenQOCD Debugging

[ GNU MCU C/C++ Packs (Experimental)

@ GNU MCU C/C++ PyOCD Debugging

 GNU MCU C/C++ QEMU Debugging

@ GNU MCU C/C++ RISC-V Cross Compiler

@ GProf Integration

i@ Library Hover help for devhelp documentation
@ LTTng Kernel Analysis

@ LTTng Tracer Control

i@ LTTng Userspace Analysis

[ Marketplace Client

@ Mylyn Context Connector: C/C++ Development
i@ Mylyn Context Connector: Eclipse IDE

@ Mylyn Context Connector: Team Support

@ Mylyn Task List

i@ Mylyn Task-Focused Interface

@ Mylyn Tasks Connector: Bugzilla

4 Mylyn WikiText

Installed Software Installation History Features Plug-ins Configuration

Version

7.0.1.2018091215...
4.1.0.2018091209...
5.1.0.2018091115...
2.6.4.2018093006...
1.1.2.2018093006...
1.4.4.2018093006...
4.3.4.2018093006...
4.3.3.2018093006...
2.2.2.2018093006...
1.3.3.2018093006...
3.3.3.2018093006...
2.8.2.2018093006...
7.0.1.2018091215...
7.0.1.2018091215...
4.1.0.2018091209...
4.1.0.2018091209...
4.1.0.2018091209...
1.7.2v20180829-...

5.20.0.v20180905...
3.24.2v20180905...
3.24.2v20180905...
3.24.2v20180905...
3.24.2:v20180905...
3.24.2v20180905...
3.0.25.201806201...

Id

org.eclipse.linuxtools.gcov
org.eclipse.tracecompass.c
org.eclipse.egit.feature.grc
ilg.gnumcueclipse.manage
ilg.gnumcueclipse.coderec
ilg.gnumcueclipse.templai
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.packs.fe
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.debug.¢
ilg.gnumcueclipse.managg
org.eclipse.linuxtools.gpro
org.eclipse.linuxtools.cdt.li
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.tracecompass.|
org.eclipse.epp.mpc.featur
org.eclipse.cdt.mylyn.featu
org.eclipse.mylyn.ide feati
org.eclipse.mylyn.team fei
org.eclipse.mylyn_feature.
org.eclipse.mylyn.context |
org.eclipse.mylyn.bugzilla.
org.eclipse.mylyn.wikitext

g Nuclei Studio

1.0.0

com.nucleisys.ide.feature.l

<

g RPM Tools

@ TM Terminal

i@ TM Terminal Serial Connector Extensions
@ Valgrind Tools Integration

7.0.1.2018091215...
4.5.0.2018091014...
4.5.0.2018091014...
7.0.1.2018091215...

org.eclipse.linuxtools.rpm.
org.eclipse.tm.terminal.fea
org.eclipse.tm.terminal.cor

org.eclipse.linuxtools.valgr
L

>

1. Brand-new Nuclei Studio, deeply integrated with Nuclei SDK,Nuclei RISC-V Toolchain and Nuclei
OpenOCD
2. New Nuclei SDK Project template wizard for GD32VF103 and Nuclei HummingBird Evaluation SoC is
provided in Nuclei Studio

a5
('_?/.

Uninstall...

Properties

Close

9-4 i%&#% “Nuclei Studio” ¥

10.f#FH QEMU 45 E i1

BHT A 1 Nuclei Studio #4417 QEMU, >(#F GD32VF103 flits k4 2% Core B LFZESLH
P E AR IIRE, X E DL RVSTAR T2 .

AT SCHI N AR —> RVSTAR Li%, X H U helloworld TAEANHY, FATHE— 4N
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helloworld K] Tf&.

A R LFE, %FF “Debug As -> Debug Configurations” T ik B % . WK
10-1, 7E#E PikFE “GDB QEMU Debugging” T4 “qemu” EERMIW EiRT. AT LTFEN
“helloworld” , FTLAItALIES “helloworld_debug qemu” , &5 Sdifs F7H “Debug”

a5 HR

@ Debug Configurations

CEeRX BT~

type filter text

] C/C++ Application
] C/C++ Attach to Application
& C/C++ Container Launcher
] C/C++ Postmortem Debugget
C/C++ Remote Application
ci C/C++ Unit
€ Debug Adapter Launcher
@ DSF PDA Application
1 GDB Hardware Debugging
] GDB Jumper Debugging
~ [ GDB OpenOCD Debugging
] helloworld_debug_openocc
& GDB PyOCD Debugging

~ =] GDB QEMU Debugging
[l helloworld debug gemu
-Link Debuggin

& Launch Group

< >
Filter matched 17 of 17 items

@

Create, manage, and run configurations

0 X
g
Name: ‘hel\owor\didebugiqemu |
| Main % Debugger ¥ Startup|% Source & Common| % SVD Path
Project:
‘hel\owor\d Browse...
C/C++ Application:
\Debug/helloworld.elf
Variables.. = Search Project... Browse...
Build (if required) before launching
Build Configuration: Select Automatically v
() Enable auto build () Disable auto build
(® Use waorkspace settings Configure Workspace Settings...
Revert Apply
Close

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA -
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& Debug Configurations

Create, manage, and run configurations

CedEX | B Y - Name: |he||0w0r|d_debug_qemu
|| Main | %% Debugger = Starlupw By Source\l =] Qommon} & SVD Patlﬂ
[E] C/C++ Application QEMU Setup 2
[E] C/C++ Attach to Application Start QEMU locally
[€] C/C++ Postmortem Debugger S - |$ s e 32 g p—
[£] C/C++ Remote Application xecutable path: {gemu_path}/${gemu_executable_32} FOWSE... ariables...
ﬁ Debug Adapter Launcher Actual executable: |G:\woke\NucleiStudio\test.202109\NucleiStudio\\tools\qemufqemu-system-riscv32.exe
@ DSF PDA Application fto ch i preferences pages or the project properties page)
[£] GDB Hardware Debugging bine Bi .
» [£] GDB OpenOCD Debugging Machine Bit: gemu-system-riscv32 ~
v [t] GDB QEMU Debugging Board name: gd32vf103v_rvstar ~
[©] helloworld_debug_gemu .
5] test0_debug_qemu Muclei RISC-V Core: | N205 ~
[c] test1_debug_gemu Download: flashxip ~
[] test123_debug_gemu
- - GDB port: 1234
[E] test2_debug_gemu = \—1
[E] test3_debug_gemu More options: -serial stdio -nodefaults -5
[€] test5_debug_gemu
[E] test6_debug_gemu
(] test7_debug gemu Enable Arm semihosting Do not open graphic windows
[] test8_debug_gemu Command line:
[E] testd debug_gemu ’ |he||0w0r|d
[T] test90 debug_gemu ] Allocate console for QEMU [JExtra verbose
[E] test91_debug_gemu GDB Client Setup
[£] GDB SEGGER J-Link Debugging
7 Launch Group Executable name: |${cr055JJreﬁx}gdb${cr055_5ufﬁx} Browse... | Variables...
Actual executable: |riscv—nuc|ei-e|f—gdb |
Other options: | |
Commands: set mem inaccessible-by-default off
set remotetimeout 250
set arch risowrv32
v
Revert Appl
Filter matched 37 of 37 items = BEY
@

10-1 #%+#% QEMU #4747 IR

QEMU [V E4HEC & 7, Hit T Machine Bit. Board name. Nuclei RISC-V Core. Download
W, R DR B QEMU #H47 H i€ L E

B  Machine Bit QEMU 1] LAfjj & 32 AL Fl 64 A AP X &

B Board name %X AN A ) Board AR AMA A L B

ARSI MBS ER BT, RESRBHIIE IR, Ak, SBIBEE A 2 A 7 A7
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B  Nuclei RISC-V Core QEMU .4 37 #2471 nuclei KZEHIAHZEA S, FFoired

B SR EZHIRFCHEASNAS . TR 7SR CPU A S HITE L.

900EF

GIIE=]|

300EF

2007

NERE] NXERE] UXRE]
(326E5E4) (64{EEE) (64{irZE4, Linux)

| NS00 || NS0OF ||N900FD| | NX900 ||NXBOUF|F\IXQDDFD| | UX900 ||UXQDOF“JXQDOFD|

| NBOD || NBOOF ||N600FD| NX600 || NXG0OF | NX500FD ‘ UX600 ”UXGDUFHJXGDDFD‘

N200 || N200E
N203 || N203E
N205 || N205E

B Download QEMU fjj 5 7 AN ik

#%VE: 2021.09 fiZff) Nuclei Studio %} 2 A A ) Nuclei Studio 817 /) TFE ) qemu #7032

il 10-2 fow, O5 RIS — R i e e, Hdr, R DT ENE,
Console H&EFH . # 74 Al e &0 R LI =ikl BT IEWI G,

ASLAFFTA A A IRRBON SR BRI, REA KRBT IR, A HE . SR A 2 sl o WA -
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@ NucleiStudio_workspace - helloworld/application/main.c - NucleiStudio IDE

File Edit Source Refactor Navigate Search Project Run RV-Tools Window Help

&|[% [®] 5Debug  ~ Ehelloworld debug g~
# Debug & Project Explorer = &l
~ [ helloworld_debug_qemu [GDB QEMU Debugging]
~ & helloworld.elf [1]
« # Thread #1 1 (CPU#D [running]) (Suspended : Breakpoint)
= main{) at main.c88 DxB001b1c
£ gemu-system-riscv32 exe
2 riscy-nuclei-elf-gdb

WBvTO AT SEFv SDumoE i AL WIS )

2 main.c =
a3 if (misa_bits.b.p) {
misa_chars[index++] = '#';

}
if (misa_bits.b.t)
misa_chars[indexs++] = 'T';

if (misa_bits.b.u) {
misa_chars[indexs+] = 'U';

if (misa_bits.b.v) {
misa_chars[index++] = 'V';

}

if (misa_bits.b.x) {
misa_chars[index++] = 'X';

}

misa_chars[indexs+] = "\8';

printf("MISA: RVEs\r\n", misa_chars);

main(void)

srand(__get_rv_cycle() | _get_rv_instret() | __RV_CSR_READ(CSR_MCYCLE));
vint32_t rval = rand();
rv_csr_t misa = _RV_CSR_READ(CSR_MISA);

printf("MISA: @xX¥lx\rin", misa);
print_misa();
for (int i = 8; § < 20; 1 ++) {
printf("%d: Hello World From Nuclei RISC-V Processorl\rin”, i);

return @;
Bee 3

102

S Console = 7 Problems © Executables ®Debugger Console 0 Memory
helloworld_debug_gemu [GDB QEMU Debugging]

Muclei SDK Build Time: Dec 29 2028, 17:18:51

Download Mode: FLASHXIP

CPU Frequency 126523411 Hz

K 10-2QEMU 45 E i A

uint32 t
nv_esr t

< » ¢

Name : misa
Details:o
Default:@
Decimal:@
Hex:0x@
Binary:@
octal:@

Registers 4
Name Value Descri ~
Type . ¥ Genera Gener,

Hame :

‘zer0 0
ra  DxB000268 < st..
“sp  0x20004fb0
gp 020000860
‘tp Dx0
0 134225212
115

0
ifp  0x20005000
s 0
iad 0
al 0
ia2 28
a3 536871036
iad B
a5 771751936
Pab 31
al 0
52 0
<30

p
Hex:@x20004fb8

Decimal: 536891312

Octal: 84880847660
Binary:108000000000000100]
Default:aéx

Update RPM packages proposal list JE

15 BB AT AR 507 B AL, 44 RVSTAR T 2% 4% “Run As -> Run Configurations” ,
5% fik ¥ “GDB QEMU Debugging” Fiiifi “qemu” JE&M B EELM. %45 Ad “Run” ,
AT LAFERE & (Console #2) & 21217 T BNt
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